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ABOUT THIS MANUAL

READ THIS OPERATING MANUAL BEFORE ATTEMPTING TO USE THE INSTRUMENT.

This manual is valid for the Audibase5 (applies from software version 5.5 onwards).

This product is manufactured by:

Amplivox Ltd. Amplivox Ltd.

10393 West 70th Street 3800 Parkside, Solihull Parkway, Birmingham
Eden Prairie Business Park, Birmingham,

West Midlands,

MN 55344 B37 7YG

United States United Kingdom

www.amplivox.com

For all enquiries please contact us under:

Tel: 888 941 4208 Tel: +44 (0)1865 880846
Fax: 952 903 4100
info@amplivox.us hello@amplivox.com
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IMPORTANT LICENCE INFORMATION

Read carefully before opening the software pack.

This is a single user software licence granted to you by Amplivox Ltd. The software remains the property of
the manufacturer and is not sold.

You, as end user of the software, may use one copy of the enclosed software installed on any single computer.
Once installed on the computer, you may make back-up copies for the purpose of security. You may not copy
the originalinstallation media, nor install the software on a second computer. When used on a network system,
you must purchase a separate licence for each individual computer on which the software will be used.

COPYRIGHT

The enclosed software is owned by Amplivox Ltd (and in parts by the Microsoft Corporation) and is protected
by United Kingdom or United States copyright laws and international treaty provisions. Neither the software
nor the accompanying manuals may be reproduced in whole or in part. You may not make changes or
modifications to the licensed software, and you may not decompile, disassemble or otherwise reverse engineer
the software.

The software may not be rented or leased to others, but you can transfer your rights under this agreement in
full provided that all copies of the software and written manuals are transferred, that the recipient agrees to the
terms of this agreement and notifies Amplivox Ltd of the transfer of the licence.

LIMITED WARRANTY

Amplivox Ltd warrants that the disks on which the software is supplied and the product documentation is free
from defects in material and workmanship under normal use. Amplivox Ltd warrants that the software will
perform substantially in accordance with the product manual for a period of 90 days from the date of receipt.

DURING THE WARRENTY PERIOD

Amplivox Ltd will replace, at no cost, any disks or printed matter that proves defective in materials or
workmanship on an exchange basis. Amplivox Ltd undertakes to replace or repair, at no charge, any software
that does not perform substantially in accordance with the product documentation. If Amplivox Ltd is unable to
replace or repair the software, Amplivox Ltd will, at its discretion and as a final remedy, replace the software
with a functionally similar program or refund the price paid for the software licence in full.

WARRENTY EXCLUSIONS

Amplivox Ltd undertakes to ensure that the product meets the specification given in the product literature: it
does not warrant that the software supplied in this package is suitable for your specific requirements or usage.
The warranty does not extend to any damage or corruption to the supplied disks or documentation subsequent
to your receipt of the product, however caused, nor does it extend to any damage or corruption of the program
image on your computer subsequent to installation.

Amplivox Ltd does not warrant the compatibility of the software on any computer other than that described in
the product specification and takes no responsibility for any incompatibility or problems arising from the use of
other operating systems or application programs on your computer.

Eap > 5
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AMPLIVOX LTD DISCLAIMS ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, INCLUDING ANY
WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE WITH RESPECT
TO THE ENCLOSED SOFTWARE PRODUCT.

AMPLIVOX LTD OR ITS SUPPLIERS SHALL, IN NO EVENT, BE LIABLE FOR SPECIAL,
CONSEQUENTIAL, OR INDIRECT DAMAGES OR LOSS ARISING FROM THE USE OR MISUSE OF THIS
PRODUCT, EVEN IF AMPLIVOX LTD OR ITS SUPPLIERS HAVE BEEN ADVISED OF THE POSSIBILITY
OF SUCH DAMAGES. IN ANY CASE, THE ENTIRE LIABILITY OF AMPLIVOX LTD UNDER THE
PROVISION OF THIS AGREEMENT SHALL BE LIMITED TO THE AMOUNT PAID TO AMPLIVOX FOR
THE SOFTWARE LICENCE.

Should you need to request replacement or repair of the software or documentation under the terms of this
warranty or if you have any questions regarding this licence agreement, please call Amplivox Ltd customer
service department quoting the licence number of the software and the date of purchase.

NOTICES

Information within this manual is subject to change without notice.

Windows and Excel are registered trademarks of Microsoft Corporation

© Copyright Amplivox Limited (2005-2019)

Eap > 6

D-0116491-C (OMO016) — Audibase Operating Manual



1.INTRODUCTION
1.1. OVERVIEW

Audibaseb is the hub of a suite of programs and instruments designed to enable health care professionals to
automatically test patient’s hearing levels using a connected audiometer, to download the test data & display
audiograms and then analyse & categorise the results. New for version 5.5 of Audibase5 is the ability for vision
test data to be manually entered. The audiometric and vision data is stored in the database alongside patient
details and may be printed if required.

Information on each patient is displayed simply and clearly, with a patient’s details page and a separate screen
for each audiometric test. Switch to the new vision functionality, and the patients details are displayed on the
familiar patient details page and a separate screen for each vision test. The user can step through each screen
(audiology and vision mode) easily by selecting the appropriate page on the screen. Although multiple records
of many patients may be stored together on the same PC, the database rapidly recalls any records for a
particular patient once a unique part of the information, for instance the patient number, is entered into the
filter screen.

Audibaseb5 stores different audiometric and vision records for the same patient as independent records, but
the user can view them all, once any one of them has been recalled. Such audiometric records are presented
graphically, superimposing automatically the latest test results on the previous results stored, enabling the
user to make a direct visual comparison between the two.

Audibase5 has facilities for printing either individual audiograms or a database summary in addition to
individual vision test results. Using the filter function, the user can also print the summary of a sub-section of
the database such as the names of all patients due to be retested between two dates, all patients with a
particular categorisation or records of patients above, below or equal to a particular age.

A key feature of Audibase5 is its ability to interface to a range of Amplivox audiometers with USB connectivity,
allowing audiometric test data to be transferred easily from the audiometer. When used with the PC850 or
Otosure audiometer, Audibase5 may also launch an automatic audiometric test, again seamlessly transferring
the results back into Audibase5.

1.2. WARNINGS

Throughout this manual, the following meanings of warnings and cautions apply:

WARNING The WARNING label identifies conditions or practices that may present danger
to the patient and/or user.

The CAUTION label identifies conditions or practices that could result in damage

CAUTION to the equipment.

Eap > :
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2. COMPUTER REQUIREMENTS
2.1.COMPUTER HARDWARE

The requirements for Audibase5.5 are the same as for the operating system being used on that hardware. As
a guide:

1 GHz processor (32-bit or 64-bit)

Video resolution 1024 by 768 minimum

1 GB of RAM (32-bit processor); 2 GB of RAM (64-bit processor)

16 GB of available disk space (32-bit processor); 20 GB of available disk space (64-bit processor)
DirectX 9 graphics device with WDDM 1.0 or higher driver

The printer designated by the Windows operating system will be used as the default printer. In addition one
free USB port is required to connect an Amplivox audiometer and for Audibase installation purposes.

2.2.COMPUTER SOFTWARE

The Audibase5 software suite is supplied on a USB stick along with device drivers and other programs to allow
connection to Amplivox audiometers.

Audibaseb, version 5.5 is supported on the following Microsoft Operating Systems:
e Windows 7
e Windows 8/8.1
e Windows 10

Eap > 8
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3.INSTALLING AUDIBASES.5
3.1.DATA SECURITY:

If upgrading from Audibase4, Audibase5, Audibaseb5.2, Audibase5.3 or
ili CAUTION Audibase5.4, any existing data should be backed up for security prior to

installing Audibase5.5.

For Audibase4 this is primarily the “audibase4.mdb” file which is located
in the directory in which the Audibase files were installed (default
C:\Program Files\Audibase4). See Section 6.15.1 for backing up this data.

For Audibaseb, Audibase5.2, Audibase5.3 or Audibase5.4 this is primarily
the “audibase5.mdb” file which is located in the directory in which the
Audibase files were installed (default C:\Program Files\Audibase5 (32-bit
operating systems) C:\Program Files(x86)\Audibase5 (64-bit operating
systems)). See Section 6.15.1 for backing up this data.

In addition, any “.csv” files that were created by using the Export function
in any version of Audibase should be backed up.

Audibase4, Audibaseb, Audibase5.2, Audibase5.3 or Audibase5.4 must
then be uninstalled using the Add or Remove Programs facility in Windows
Control Panel.

Both types of data mentioned above will remain after the uninstall process
and when Audibase5.5 is installed it will be able to access these data files
if the default installation directory is used. If a different directory is used
the “audibase5.mdb” file must be copied into it. Note this will always be
the case when upgrading from Audibase4.

3.2. ADMINISTRATOR AND USER PERMISSIONS

It is often the case that a user with “administrator” permissions is allowed to install and/or upgrade application
software, while the user of the application has a “standard user” account (Windows 7 notation is used here).
In line with this scheme, the Audibase5 folder will need to have at least “read & execute” and “write”
permissions set on it for the intended user. However depending on the precise configuration of the computer
it may be necessary to grant “full control” to this folder, or even grant the Audibase user “administrator” rights.

It is recommended that the Windows User Account Control is set to “never notify” (Control Panel — User
Accounts — Change User Account Control Settings). If this is not done, then certain functions within Audibase
will be restricted and this may result in error messages.

3.3.  INSTALLATION PROCEDURE

Installation is a straightforward process but the steps must be carried out in the correct order. To
ensure you are familiar with the instructions please read this entire user manual before commencing
installation.

Ensure that the Windows date & time formats (in the Region & Language group) are set to dd/mm/yyyy
and hh:mm:ss (without AM or PM displayed). If this is not done Audibase may display error messages.

The process described below refers to a “typical’ installation on a new PC. Depending on the actual
configuration of the PC being used and whether any previous versions of software and/or device drivers have

Eap > :
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been installed some alternative steps may be needed. Refer to Appendix 1 which contains installation
troubleshooting notes and further guidance.

The user is also referred to Appendices 2-8 for specific guidance regarding the actual audiometer that is to be
used with Audibase.

Installation is a two-stage process (please ensure both are completed):
1) with the audiometer disconnected from the PC, install the Audibase software on the PC as described
in section 3.2.1.
2) With the audiometer still disconnected from the PC, install the Amplivox device drivers to enable USB
communication between the PC and the audiometer as described in section 3.2.2.

3.2.1 INSTALL THE AUDIBASE SOFTWARE

a) Disconnect any USB based audiometer from the PC.

b) Switch on the computer and wait until the Windows desktop appears on-screen. Do not open any other
applications before installing Audibase5.5. If any programs start, close them before proceeding to the next
step.

c) Insert the Audibase5.5 USB stick and navigate to the USB stick,. Select either the ‘Windows 7 Installer
or ‘Windows 8 & 10 Installer’ folder.

Help

Organize « Open Burn Mew folder

4.7 Favorites Windows 7 Installer
Bl Desktop Windows 8 & 10 Installer
4. Downloads
23 Dropbox

=l Recent Places
> [ Libraries

48 Computer
> &, 05 Win 7(0)
== Audibase 5.5 (DY)
4 Windows 7 Installer

4 Windows & & 10 Inst

@' USB Driver Installation 32-Bit Operating S... Date modified: 19/11,/2014 15:07

S Application Size: 893 KB

oy .
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d) Then select ‘setup.exe’ and follow the on-screen commands.

29 R —

File Edit View Tools Help

Organize = Open Burn Mew folder

4.0 Favorites USE drivers
Bl Desktop "L ADBS5-Registration-Form.pdf
4 Downloads Bl Amplivoxico
%3 Dropbox - OMO015-10 Amplivox PC850 Operating Manual pdf
= Recent Places -~ OMO016-13 Amplivox Audibase 5 Operating Manual.pdf
L OMO022-3 Amplivox Otosure Desktop Operating Manual.pdf
> | Libraries = vide to Installing Amplivox USB Drivers. pdf

4 M Computer
> &, 05 Win 7(7)
e Audibase 5.5 (D7)
4 Windows 7 Installer
4 Windows 8 8 10 Inst

¥ USE Driver Installation 32-Bit Operating S... Date modified: 19/11/2014 15:07
- Application Size: 893 KB

e) The following screen will be displayed first. If you have any other applications running, click ‘Exit Setup’,
and close the running applications and return to step c). If no other applications are running, click ‘OK’.

g Welcome to the Audibases5. 5 installation program.
F—g

Setup cannot install system files or update shared files if they are in use.
Before proceeding, we recommend that you dose any applications you may
be running.

Exit Setup

f) When the installation screen (below) is displayed the location for the program files may be selected.

Begin the installation by dicking the button below.

Click this button to install Audibases5. 5 software to the spedified destination
i| directory.

Directory:

C:\Program Files (x86)\Audibases) Change Directory

Exit Setup

g) The default installation directory is as shown (example shows a 64-bit operating system). To install to a
different directory, click ‘Change Directory’ and select the required directory. If installing on a network,
install the program on the computer that will be used to hold patient test results and run tests on patients.

11
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h) The option to select an alternative program group is then presented.

Setup will add items to the group shown in the Program Group box.

You can enter a new group name or select one from the Existing
Groups list.

Program Group:

Existing Groups:

Accessories
Administrative Tools

Dropbox

Maintenance
Startup

Continue |

i) To use the default group click ‘Continue’ to proceed.

j) If updates, Windows or otherwise have been applied to the PC, it is possible that the following conflict
message may be displayed one or more times. Select ‘Yes’ to each instance of any displayed message.

Earion Conti )

A file being copied is not newer than the file currently on your

system. Itis recommended that you keep your existing file.

File name: 'C:\Windows\System32\msjtes40.dll
Description: ‘Microsoft Jet Expression Service

Your version: '4.0.9756.0°

Do you want to keep this file?

k) Click ‘OK’ on the final dialogue box to complete the installation.

Audibase5.5 Setup was completed successfully.

[) Continue with the device driver installation (below).

12
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3.2.2 INSTALL THE AUDIOMETER USB DEVICE DRIVERS

a) Navigate to the USB stick. Select the

I« Avivssess » Vincors msalenruser- | | =

Organize « Open

4.0 Favorites
Bl Desktop
4 Downloads
%3 Dropbox

=1l Recent Places
> | Libraries

M Computer
> &, 08 Win7.(C5)
"= Audibase 5.5 (D:
4 Windows 7 Installer
[> 1. USB drivers
eb5.cab

‘USB drivers’ folder and select ‘Setup’.

File Edit View Tools Help

Burn MNew folder

, amdid

, i386

| Static
=] dpinstaml
“E dpinst-amd6d.exe
“E dpinst-x86.exe
|| ftd2wech
=/ ftdibus.cat
4 | ftdibus.inf
=4 ftdiport.cat
4% | ftdiport.inf

§' USB Driver Installation 32-Bit Operating S... Date modified: 19/11/2014 15:07

Application

=N

Size: 893 KB

b) Install the USB Drivers from step b) as described in the Amplivox Operating Manual for USB Driver
Installation (D-0115682 / OM032). This can be found in the same location as this operating manual. Do
not connect the audiometer to the PC until instructed to do so.

If the latest version of the USB drivers are already installed, for example if an Amplivox audiometer or
tympanometer has previously been connected to the PC, performing the installation again is not
necessary. However, there are no adverse consequences in doing so — the steps f), g) & h) in Section 3
of the Operating Manual for USB Driver Installation will be skipped, and when connected your instrument

will be immediately ready for use.

Eap >

D-0116491-C (OMO016) — Audibase Operating Manual

13



4.STARTING AUDIBASES

e Click Start — All Programs from the task bar at the bottom of the screen
e Select the Audibase5 group and click Audibase5.5 to open the program

Alternatively a shortcut icon may be placed on the Desktop in the usual way.

Product Registration

Before use, Audibase5 needs to be registered with Amplivox. The screen shown below will be displayed when
opening Audibase5 for the first time:

I3 Registration (o] o |

Please reqgister the software by giving the ‘software number' to your
supplier. They will supply the registration key. Enter this in the box
below and press DK

Software Number: EEF7D4

Reqistration Key: |

oK LCancel

Send or email the following details to your distributor or directly to Amplivox (if the product was purchased
directly):

e the customer name
¢ the Software Number from the registration screen
¢ the Audibase serial number (located on media label)

Please make sure that upper and lower case letters are correctly identified. A Registration Key will be provided
by return to be entered as shown above.

A screen requesting a Username and Password will then appear:

B} Login X

Uszer name
Password Cancel

The use of a Username and Password is optional but the latter can act a means of security if required. The
Username is not saved by Audibase and would typically be the name of the operator (if entered, this name is

displayed as the “Examiner” on the Details page - see Section 7.2). To skip the entry of Username and
Password click on OK.

oy y
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If required, enter a Username and click OK without entering a password. A password (if required) is entered

later (see Section 6.15.2).
The screen below, the Register Screen, will then be displayed. Initially this will be blank as no patient details
have been established. The menu bar and tool bar contain the functions that are required for the storage and

analysis of audiometric test results.

(63 Audivase 55
File Setup Test Edit Database Connectto Type Help
2 Al Al | Oy o= =TI -
i _;.yHT Xz :E AT '@"
@] X[ 9 M T2 || SAQ @
l?‘“ﬁeg\“ﬁe}“} Deta\\s} Audmglams} Uuastmnnaue]
[Patient Mo [Sumame [Forenames | Last Test] Time of Test| Previous Test] Date of Birth| Categorisation [Posttion/Rank. ]
| 3
Patients: 0 Records: 0 Filter: Off Sorted:

15
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5.AUDIOLOGY MENU BAR FUNCTIONS

File Setup Test Edit Database Connectto Type Help

Selecting any of these functions will provide a drop-down menu with further options. Click on the option
required. For further information on the use of each option see the section listed below.

5.1.DROP-DOWN MENUS

File Import Database Find
Import File Filter Criteria
Import Audibase 3.1 Sort
Export Create Average
Print Preview Add New Average
Print Insert Average
Batch Print Type Audiology
Exit Vision
Setup Configuration
Test Launch Test
Get Test Data
Edit Add Patient
Insert Audiogram
Insert Vision
Edit
Save

Cancel Insert/Edit
Change Patient No.
Delete a Record
Delete a Patient

5.2.CONNECT TO

Use when data is to be imported from or exported to a CA850 audiometer. Refer to Appendices 2 to 4.

5.3.HELP

The About menu provides the Audibase5.5 version number as well as details of a lower-level software module
(the “Loadit” interface) along with support contact information. Please quote these details when contacting
Amplivox with any technical queries.

E) About Audibase 5.5 x

Audibase 5.5

Copyright € Amplivax 2015

Wersion 5.5.101  Loadit v3.7.0.0

for support please contact:
suppork@amplivos. (bd. uk
sy amnplivos. . uk

oy y
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6. AUDIOLOGY TOOL BAR FUNCTIONS

The tool bar displays a number of function icons. When the mouse is positioned over an icon, a tooltip will
identify the function of the icon. To start the function, click the icon.

6.1.PREVIOUS PATIENT; NEXT PATIENT

é* These two functions enable the user to move between patient records, the arrowhead in the
first column of the register page showing which patient is currently selected.

6.2.NEW PATIENT

Click on this icon to enter Edit mode and to insert the details of a new patient into the
Patient’s Details page.

6.3.FIND

Q

Click this icon to search the database for a specific record.

6.4.QUESTIONS

u Access the patient questionnaire after a test has been run and when in Edit mode by cIickig

=]
this icon. If this function is required prior to the actual test click the Insert Audiogram

icon on the tool bar.

6.5.LAUNCH TEST

(_) This can only be used with a connected Amplivox PC850 or Otosure audiometer. Use this

1] function to start running a test on the PC850 or Otosure. Remember to save the audiogram
at the end of the test. Refer to Appendix 7 for connecting the PC850 and the separate
operating manual for the PC850 audiometer for further details about the operation of this
instrument. Refer to Appendix 8 for connecting the Otosure and the separate operating
manual for the Otosure for further details about the operation of this instrument.

Note: if no patient records exist (e.g. after installation) it will not be possible to launch a test until a
new patient is added — Section 6.2

6.6.GET TEST RESULTS

J Click on this icon to retrieve test results from a connected Amplivox audiometer. Refer to
= Appendices 5 to 7 depending on the audiometer.

Note: this functionality is not supported on the Otosure audiometer.

Note: if no patient records exist (e.g. after installation) it will not be possible to upload results until a

new patient is added — Section 6.2
> .

D-0116491-C (OMO016) — Audibase Operating Manual




6.7.SAVE

hl 11 Click this icon to save any changes to a patient’s records or test results.
6.8.FILTER
Click this icon to bring up the filter function. Insert the search criteria and click Apply Filter
at the bottom of the screen. To select the current record only, click Current Record at the

bottom of the screen. Alternatively to search by one of the current patient’s criteria, click
Current next to the appropriate field. To clear the filter before using a different filter, click

Clear Filter.
6.9.SORT
A Use this icon to rearrange the order in which the database is presented on the Register
Il screen. Make the selection and click OK.
6.10. PRINT PREVIEW
|-| Click this icon to bring up the Print Options box and choose between printing the currently
= selected audiogram or a summary of the filtered database. Make your choice and click OK.
The Print Preview screen will appear. To print, click the printer icon found in the top left
hand corner of the screen.
%I To print directly without displaying the preview screen use File then Print from the menu bar
and choose audiogram or database summary.
6.10.1. PRINT AUDIOGRAMS

The printout of the patient’s audiogram will include all the patient details, audiograms for left and right ear and
the questionnaire. If the Audiogram Band option has been selected for printing (see Section 6.15.4) then
hearing performance bands will be printed on the audiogram.

6.10.2. PRINT DATABASE SUMMARY

The database summary printout shows details of the database selected. A summary of the whole database or
a sub-section of the database may be printed.

2l
To print the database in a particular sequence, first sort it by clicking Sort Z ¥ and then choose how the
database is to be sorted before using Print Preview.

To print a particular subsection of the database (e.g. by Recall Date), click Filter ] and set the recall dates
between which the filter is to be applied. Click Apply Filter and then go to Print Preview.

6.10.3. PRINTING THE ENTIRE DATABASE (BATCH PRINT)

All of the audiograms in the database may be printed using a single command.

Eap > ’
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From the File drop-down menu select the Batch Print option as shown below:

( -] Audibase 3.3 [ KG0O1, Kelly Game, on 09/04/2015 | [BL Left: ] [BL Right:

Setup Test Edit Database Connectto Type Help

0

=

Import 3
Export _‘ 'f,)

liohhaire ]

H

jx2

) AETNS s

|

(——]
| AT
[ T)

A

‘@

Print preview

Print Ctrl+P Forenames Last Test| Time of Test] Previous Test [ ate of Birth| Categarization
Batch Print Crl+B Kelly 09/04/2015 133306 09/03/1987[HSE: 2B 4-nodata
Henry 09/04/2015 1326812 09/04/2015 03/03/1975[HSE: 14R
Bt Paul 09/04/2015 132702 09/04/205 01/05/1965HSE: 2R 4B
R achel 09/04/2015 120518 09/04/2015 08/09/1970[HSE: 2R
[ [MEO0T [Black Max 09/04/2015 120334 15/0341981 [HSE: 1 4-nodata

A confirmation dialogue box will open which also gives the option to include printing the questionnaires.
6.10.4. CHANGING THE USER DEFINED PRINTOUT TITLE

To customise the printout title (i.e. Adding a company name), the section “[Print Report Title]” in the patient
details file requires amending. See Sections 6.15.9 and 7.3 for details & examples.

6.11. EXPORT REGISTER DATA
?{' 1l Use this icon to transfer the selected/displayed data as an electronic .csv (comma separated

~ variable) file into another application (e.g. Microsoft Excel).

6.12. EDIT

Click this icon to enter Edit mode. Use this function to add details to or otherwise modify a
patient’s record and use the Save icon (see Section 6.7) to save the changes.

To cancel an edit, or if the changes are not required, select the Edit drop-down menu and then the Cancel
Insert/Edit option, or use the Cancel Insert/Edit @ toolbar button.

To amend an existing patient number, select the Edit drop-down menu and then the Change Patient Number
option. Complete the dialogue box as required.

6.13. INSERT AUDIOGRAM
-] Use this function to manually enter a patient's audiogram details onto the Audiogram
screen. Please note that you can only enter results on the lower row of data boxes.
6.14. DELETE RECORD
? Use this function to delete the currently selected audiogram. To completely delete a
I|ﬁ|l patient’s record, either delete each audiogram separately or use the Delete a Patient option

from the Edit menu.

Note: Use the Delete a Patient option with caution. The operation cannot be undone. It is recommended
that a back-up of the database is created first.
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6.15. CONFIGURE

y This function will allow the user to customise the settings used by the program. Clicking the
A Configure icon (or selecting Configuration on the Setup drop-down menu) will display the
Configuration dialogue box:

F ~
B Configuration [&J

Backup/Repair | Database Setup] Questionnaire | Test Analysis | Connection | Patient Options

LCancel

Make Backup Bepair D atabaze

There are six configuration pages relating to:

Backup/Repair
Database setup
Questionnaire
Test Analysis
Connection
Patient Options

Access any of these pages by clicking on the appropriate page tab.

6.16. BACKUP/REPAIR

Use the two functions on this page to protect your data.

6.16.1. MAKE BACKUP

Select Make Backup to access a Save as... box to make a backup of the database. Select a name for the
backup file and click Save.

6.16.2. REPAIR DATABASE

This function allows the user to repair a corrupt database. We suggest that you use this function if the database
is not working correctly and you have not made a recent backup. Click Repair Database and the computer will
try to repair the database.

6.16.3. DATABASE SETUP

The purpose of this page is to allow the user to change the default file used as the database file and to
change/add password access.

oy .
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.
B Configuration

Backup/Pepair  Database Setup | Questionnaire | Test Analysiz Eonnection] F‘atientDptions]

Database File |E: “Program Files\audibaseFhaudibases. rmdb Browse

Advanced Settings

Change Pasaword Serial Com Port

LCancel

b

6.16.4. CHANGING THE DEFAULT DATABASE

To select a new database that you wish to use as the default database, click Browse, select the directory
where the database is stored and click on the name of the new database. Click Open and a message will
appear asking you to confirm the change. Click OK if you wish to change the default database, then close
down and reopen Audibaseb.

6.16.5. CHANGE PASSWORD

To set up a new password or to change an existing one, click on Change Password in the Advanced Settings
box, enter the current password (if any) and then enter the new password twice, confirming it the second time.
Note the password you set is case sensitive.

IMPORTANT: You must make a note of the password in order to ensure you have access to the database. If
you forget the password you have set, you may not be able to access the database.

6.17. SERIAL COM PORT

Used to specify the Serial Com Port for older audiometers.

6.18. QUESTIONNAIRE

B Configuration

Backup/Flepair | Database Setup  Questionnaire TestAnaI}lsis] Connection] PatientDptions]

Have any of your blood relatives [Mother, Father, Sister(s] or Brother(s] only) had - E dit
hearing losz prior to the age of 507

Have you naticed a recent change in your hearing?

Do wou have trouble understanding nomal conversation?

Do wou regularly participate in an activity using Firearms, Power tools, eroplanes,
Motor boatz or Farm machinery?

Do wou currently work, in a noisy area requiring hearing protection’

Do wou currently wear hearing protection”?

Do wou currently wear hearing protection - Plugs?

Do wou curmrently wear hearing protection - Muffs?

Frequent earaches, ear infections or drainage from ear?

Ringing in the ear, face numbress or dizziness?

m

LCancel

The purpose of this page is to enable the patient questionnaire supplied with the database to be tailored to
specific requirements. To edit the questions, click Edit and make the appropriate changes. To save the

changes, click OK.
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6.19. TEST ANALYSIS

B Configuration [&J

Backup.-"F!epair] Database Setup] Questionnaie T est Analysis ] Connection | Patient Options

Categorisation
v HSE Recategorize [

[v 5T5

[v MIHL Wiew STS Age
Corrections
Audiogram Bands
[~ Enabled

=
[~ Predictive

h

The purpose of this page is to indicate which categorisation scheme(s) the program is currently using and to
allow the selection to be changed.

It also enables hearing performance bands to be displayed and printed on the audiograms in addition to
displaying and printing a predictive band. To display performance bands on the audiograms, select Enabled
in the Audiogram Band options. To print the hearing performance bands, select Print. Note: Print can only be
selected if the Enabled option is also selected. To display and print a predictive band on the audiograms select
Predictive. Refer to section 7.4 for further details of performance bands.

The categorisation scheme(s) available for selection will depend on the version of Audibase installed.
Note: Only suitably qualified practitioners should undertake the assessment of audiometric data.

As an aid to this assessment Audibase produces a hearing categorisation once hearing thresholds and other
patient data are established.

One or more of the scheme(s) displayed in the Categorisation option may be selected as required followed by
the ‘Recategorise’ button. The revised categorisations will apply to all records in the database and confirmation
is required. An alternative selection of categorisation scheme(s) may be made at any time and applied to the
database, and the most recent selection will be saved when the program is closed.

Details of the various categorisation scheme(s) available are provided in the following sections and the results
of the selected categorisation(s) are displayed (as appropriate) at the bottom centre of the audiogram page
(see Section 7.4).

6.19.1. HSE CATEGORISATION

This is derived from the UK Health & Safety Executive (HSE) scheme incorporated into the UK Control of
Noise at Work Regulations 2005 (L108). These regulations define 5 categories of hearing as follows:

e Category 1 — acceptable hearing ability

e Category 2 — mild hearing impairment

e Category 3 — poor hearing

e Category 4 — rapid hearing loss (based on a previous test within 3 years)

e Category U — unilateral hearing loss (based on a comparison of left & right ears)

Each ear of a patient is placed into one (or more) of the above categories based on the hearing threshold
results at a number of frequencies and the age and sex of the patient. Based on the resulting categorisation,
a patient may be warned about hearing ability or referred for further medical advice. For detail of the derivation
and application of these categories the user/operator is referred to the regulations.

Eap > :
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As long as the required data is available (e.g. hearing thresholds have been established at the required
frequencies) Audibase will perform this calculation and present the hearing categorisation results.

The category identifier (1, 2, 3, 4 and ‘U’) will be followed by an associated coding which shows which part of
the audiogram data caused the category identifier to be assigned. These codings are:

o L (left)
e R (right)
e B (both)

e no data (previous test data is not available)
e Age <18 (HSE tables do not cover this age range)
e Data incomplete (required threshold data not available)

Examples of HSE categorisations presented by Audibase:

o 1

e 14-nodataU Age <18
e 2R3L4RU

e 2B4RU

e 3B4-nodataU

e 2R3LA4L Age<18

e 2R 3L 4-nodataU Age <18

e Data incomplete

e No sex chosen

e No sex chosen Age <18

¢ Invalid patient age (e.qg. if date of birth age was not provided or is inconsistent)

As shown above, to differentiate each part of the categorisation, there is a space between category identifiers.

6.19.2. NIHL CATEGORISATION

The noise-induced hearing loss (NIHL) categorisation criterion is a straightforward pass/fail decision based on
the average of the hearing thresholds at 2000Hz, 3000Hz and 4000Hz. If this is 25dBHL or more for either ear
then the NIHL classification applies.

No allowance is made for the age or sex of the patient when performing the NIHL categorisation.

Example of the NIHL categorisation presented by Audibase:

e NIHL-R
e NIHL-L NIHL-R

6.19.3. STS CATEGORISATION

Standard Threshold Shift (STS) is a categorisation criterion applied by the US Occupational Health and Safety
Administration (OSHA). It is a straightforward pass/fail decision based on the differences in hearing thresholds
at 2000Hz, 3000Hz and 4000Hz from the thresholds at the same frequencies taken from a previous test
(baseline). These differences are averaged and if the result is 10dB or more for either ear then the STS
classification applies.

According to OSHA guidelines corrections may be made for the age and sex of the patient when performing
the STS categorisation and these corrections have been incorporated in Audibase 5.5 for displayed and printed
results. However the user should refer to OSHA guidelines regarding the application of this categorisation. The
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table of age corrections may be displayed using the ‘View STS Age Corrections’ button. ‘Change Table’
switches between corrections for male & female.

Example of the STS categorisation presented by Audibase:

e STS-L
e STS-L STS-R

6.20. CONNECTION
rﬂ Configuration &J‘

Backup/Repair | Database Setup] Questionnaire | TestAnalpziz  Connection | Patient Optiong

For connection to CABR0 Audibaze audiometers please uze this screen.

LCancel

CA850 Part
& 55 T = Delay between exported records
54 05 1s
83

The purpose of this page is to set up the connection to the required model of the CA850 audiometer. Refer to
Appendices 2 to 4 for details.

6.21. PATIENT OPTIONS
rﬂ Configuration Iér

Backup.-"F!epair] Databaze Setup] Questionnaire | Test Analysis | Connection  Patient Options l

[campany] o Edit
= LCancel

[location]

[exariiner]

[leaving reazon]

[position]

The purpose of this page is to enable the patient option dropdown lists (displayed on the register tab) to be
populated with predefined options. To edit the patient options, click Edit and make the appropriate changes.
To save the changes, click OK. Section 7.3 provides further details.

6.22. CANCEL INSERT/EDIT
Click this icon to cancel an insertion, or to discard changes if they are not required. The
functionality is exactly the same as using the Edit drop-down menu and then the Cancel

Insert/Edit option as described in section 6.12.

oy g

D-0116491-C (OMO016) — Audibase Operating Manual



6.23. SWITCH TO VISION MODE

Click this icon to switch from audiology mode to vision mode. The vision screen opens as
an additional screen overlaying the audiology screen. Please refer to sections 8-10 for full
details on Audibase vision mode functionality.

2

oy ,
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7. THE MAIN AUDIOLOGY SCREENS

7.1.THE REGISTER SCREEN
[ audivase 5.5 [KGOOL Kelly Game, on 09/04/2015 ] B

Eile Setup Test Edit Database Connectto Type Help

‘” =T A Q) <
==L 3 by y b
o« A T4 = /|22 AQ e
{Register | Detals | Audiograms | uuasunnnaue]
Patient No Surname Foienames Last Test| Timeof Test| Previous Test) Date of Birth| Categorisation Paosition/R ank
»[KGOO1 Game Kelly 03/04/2015 13:3208 09/03/1987|HSE: 2B 4-no data -
JHOO1 James Henmy 03/04/2015 13:28:12 03/04/2015 03/03/1975|HSE: 1 4B Quality Engirer
PRO01 Foggers Paul 03/04/2015 13:2702 09/04/2015 01/05/1965|HSE: 2R 4B -
RS5001 Smith Rachel 03/04/2015 12:0%:18 09/04/2015 023/03/1970/ HSE: 2R
[N Black Max 03/04/2015 12:03:34 15/03/1981|HSE: 1 4-no data

Patients: 5 Records: & Filker: Off Soited:

This screen when populated will show details of each patient. Use the left and right arrows at the top left hand

side of the screen to select a patient.

7.2. THE DETAILS PAGE

] Either click on the New Patient icon or click on the Details tab (if patient data is already

loaded) to access the Details page below:

Eile Setup Test Edit Database Connectto Type Help

. [—] :
X3 =T 3wy < =
L JARIEN T4 = /|22 AQ e
Register | Detall | duciograms Quasunnnaue]
Latest Data
Patient Address Teat
Fatient Mo JaH0O1 Jamplivox Lid Test Type Computer -
Sumame [sames | Dasis Park Date of Test  [09/04/2015
Forenames [Hermy [Evnsham Tirne of Test 132812
Fastion/Rank [ sty Enginer - [0stordshire Previous Test  [pa/04/2m5
Depattment/Urit  [RzD ERCELE Eaminer I -
Company [amplives - T3 Serial no. 30001
Location Dwfordshire = Calibrated 01/03/2015
Diate of Bitth 03/031975 Dates Recall Date )
Date Joined ]
& Mals  Femals 38 Jane 05/01/2012 BaselineLeft  [Fist Audiogram
Status ; DeteLef R — Baseline Right  [First Audiogram

LeaingResson [ ] Length of Service [3yrs 3mnths

User Defined Fields

Categorisation F1 ,ﬁ

HSE: 148 F2 | j

Notes

Patients: 5 Records: & Filker: Off Soited:

Details may be added and/or edited for each patient as required. Ensure that for each patient a unique patient

identifier number is used.
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Note that Audibase automatically fills in several boxes in the Test area. They are:
e The box labelled Examiner if a “Username” has been entered on the password screen (see Section
4).
e The boxes labelled Test Type, Date of Test, Time of Test, Serial Number, Calibrated and Recall Date
after a test has been run using the PC850 or Otosure audiometer and the results saved in Audibase.

Only enter data in the Test area if audiometric data is being entered manually or if a previously recorded
audiogram is being entered and other pertinent details are to be recorded for display on the screen.

7.3.EDITING DROP-DOWN MENUS ON THE DETAILS PAGE

To facilitate data entry, commonly used items may be selected via drop-down menus. These include the entries
for “Company”, “Position”, “Leaving Reason” and are displayed on the Details page with a down arrow at the
right of the data input box.

The contents of these drop-down menus may be defined by the user.

To edit the contents of a drop down menu, select the Configuration form and select the Patient Options tab.
Then select the ‘Edit’ button. The following message will be displayed:

PatDetails Backup l ]

Would you like to make a backup copy of the current patient details file?

No

It is recommended that a backup copy is made, so select “Yes’ and enter a name for the backup file. You can
then edit the patient detalils:

B Configuration

Backupa’Hepair] Database Setup] Questionnaire | Test Analysis | Connection PatientDptionsl

[zomnpany] n Edi

Amplivox
‘wihite & Co = LCancel

|

[location]
Oxford
Banbury

[examiner]
. ane Harrizon
hax Black

[leaving reaszon] -

[F1], [F2] & [F3] are user-defined fields that may contain any pertinent notes or observations.
Text inserted under [F4] is displayed within an additional section of the [F3] drop-down menu.

Text inserted under [Print Report Title] will be printed at the top of any audiogram printouts. Only one line of
text should be inserted. Any existing options may be modified or deleted in the usual way.

Do not delete or modify any of the section headings.
When you have finished editing the patient options, press the ‘OK’ button to save your changes. Alternatively,

select ‘Cancel’ to discard any changes.
The following will be displayed if you select ‘OK’:

Eap > .
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Patient Details File

55)

exit the program

The patient details file has been edited. For these changes to take effect please

Select ‘OK’ and then close and re-launch Audibase for the changes to take effect.

Register Details ]Audiograms] Questionnaire]

Edit Mode
Patient
Patignt Mo,

Surname
Forenames
Postion/Rank
Department/Unit
Company
Location

Date of Bith

Status

Leaving Reazon

7.4.THE AUDIOGRAM PAGE

Select the Audiograms tab as shown below:

LedLed L

Armnplivox
White & Co
S

" Male

" Femalz

Led e

File Setup Test Edit Database Connectto Type Help

TN T

A

]
J=52]

=

==
]

| Al Q] @

Register | Detalls Audiograms | Questionnaie |
125 280 500 YR 1k 15k Zk 3k 4k =3 3
- rororororr-rorirr
5 [ [ o o o [ [ 5 [0

dB
10

09/04/2015 13:27:49

125 250 500 P01k 15k 2k 3k 4 Bk Bk

- rororror-r-rrir r
o fio o [ o 5 o [ [5 o [o

dB
10

1] 0 -
10 10
20 o o
0 n
0 0
50 50
80 &0
70 n
80 L)
80 80
100 100
10 10
120 =l 120
125 250 500 1k 1.5k Zk Ik 4k Bk Bk - 125 250 500 1k 1.5k 2k 3k 4k 6k Bk
HSE: 1 4-no data
B Left Ear Tof Right Ear K
Fatents. 5 Fiacords: 5 Filler, Off Sorted

If required, another previously recorded audiogram can be manually entered on the lower line of the two rows
of data boxes, when the insert audiogram functionality is used (refer to section 6.13). See below for an

example:
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Eile Setup Test Edit Database Connectto Type Help

=

(—1]
AT
e

AlQ @

O REGIETETR LA

Register | Detals Audiogiams | Questionnaie |

 Edit Mode
125 280 500 780 1k 18k 3k 4 Bk Bk

|5_ lE_ |5_|_|D_|D_|D_ lE_ l?lﬁ_lg_ 09/04/2015 13:27:49
[5= [~ o~ [ [0 [ f5 5 B fE 5

dB

£

BY:

523385883 e

Ll

¥ Baseline? Left Ear et

125 280 500 PO 1k 15k Zk 3k & Bk Sk
N N O A N M M M O
fig” f&" o [ Fs fE fo T

ine?
Right Ear Baseline? [@

Patients. 5 |Records: 5 [Filter, Off [Sotted

Note that audiometric data may also be transferred from a connected supported audiometer (see Section 6.6).

If the Audiogram Band option has been selected (see Section 6.15.4) then hearing performance bands will be

displayed on the audiogram as shown below.

) Audibase 5.5

File Setup Test Edit Database Connectto Type Help

@ 2|0] 9 V&=

&

AlQ @

(—1]
1A T
&

Register | Detail: | Audiogiams | Duestionnaire |

125 280 500 780 1k 18k 2k 3k 4 Bk Bk

|5_ |5_ |5_ l_ IU_ IU_ IU_ IS_ l? |5_ IU_ 09/04/2015 13:27:49

|5_ |5_ lU_ l_ W W ﬁ l? E l? |5_ 14/04/2015 14:51:50
Colour Key

125 280 6500 70 1k 1.5k 2k 3k 4 Bk Sk
R R A A A 2 (R G R R
fie” & fo [ fs fE fo fa fan fi5 foo

B a8
410 = 10
0 [}
0 0
20 2
0 20
4 4
50 [-- 50
] 60
] m
20 20
%0 90
100 100
1o 1o
120 | 120

125 250 500 M 1Sk 2 3 4 6k Bk 125 250 500 M 1Sk 2 %k 4 Bk 8k

HSE: 148
i 20f2 ine?
I Bsles Left Ear Right Ear D=ZIzY [0
Patierts: 5 |Records: 5 [ Filter: OFf | Sorted:

Selecting the ‘Colour Key’ button displays the key for the colours used to represent the hearing performance

bands in the audiograms.
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Eile Setup Test Edit Database Connectto Type Help

=

(—1]
AT
e

Al Q¢

@@ N2/ 9ty T2 a2

Register | Detals Audiogiams | Questionnaie |

15 250 500 7E0 1k 1Bk 2k %k 4k Bk Bk

B [ [ [ [ F [6 [ [§ 0904215132749

g 5 [0 [ [0 [w [5 f5 [ fis [f 14/0420151451:50
‘Colour Kay?|

125 280 500 PO 1k 15k Zk 3k & Bk Sk
N N O A N M M M O
fig” [&" o [ fs fE fo w0 fan fi5 fod

dB
) Normal Hearing

o

w0l Wid Loss.

o Moderate Loss

)

40 Severe Loss

50

50 Profound Loss

70

80

30

100

110

120 -

125 0 W0 1k 1.5k Zk 3k L Bk Bk
HSE: 148
Il Buszitney Left Ear Zof2 Right Ear Bt ]
Patients: & |Records: & [ Filer, Off [Sarted:

The performance bands displayed are:

-10dBHL to +20dBHL:
+20dBHL to +40dBHL.:
+40dBHL to +60dBHL.:
+60dBHL to +90dBHL:
>90dBHL:

Normal hearing

Mild hearing loss
Moderate hearing loss
Severe hearing loss
Profound hearing loss

To disable the colour key, press the ‘Colour Key’ button again.

If the Predictive option has been selected (see Section 6.15.4) then banding indicating typical age-associated

hearing loss (AAHL) will be displayed on the audiogram as shown below.

File Setup Test Edit Database Connectto Type Help

i A,/ I W | T2 3 -
<o 2|0 9 T4 =l= /=T A Qe
Register | Detale Audiogiams | Duestionnaire |
125 2650 500 780 1k 1Bk 2k 3k 4k Ek. 8k 125 250 600 7E0 1k 18k 2k 3k 4k Ek L
T fr R R R @ [ swewamstms [ R fr R b B [ R AR
ol ol ol el el ol el el ol el ol Al
dB a8
410
[
L et
20
0
4
s |--
]
0
20
%0
100
1o
2
HSE: 1
B BeesTas?? Left Ear Zof 2 Right Ear D=l [0
Patients: 5 |Records: & | Fier: Of | Soited:
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230 00 730 1k 1.5k 2k 3k 4k 6k Bk

The AAHL is dependent on age and sex of the patient. The white line through the centre of the grey shaded
area is the 50t percentile. The grey area above this line represents the population between the 50t and the
75t percentile, and the grey area below this line represents the population between the 50t and the 25t
percentile.

dB

75th Percentile

Tl oo oo

DD b oo mm e

1 e

120
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Depending on your edition of Audibase, a ‘Baseline?’ check box may display beneath each audiogram. This
only displays in the ‘OSHA’ edition of Audibase. The ‘Baseline?’ checkboxes are used in conjunction with the
‘STS’ categorisation (please refer to section 6.15.7). To change the baseline audiogram, select the audiogram
you wish to set as the baseline, select Edit and then tick the ‘Baseline?’ box for either or both ears as desired.
Save your changes. The baseline audiogram for STS categorisation is how updated.

Select the Questionnaire tab and then click on the Questionnaire toolbar button. u Complete the presented
guestionnaire (example below) using Yes, No or text to answer the questions, Forward and Back to move
through the questionnaire and Delete to remove any questions from the questionnaire. Click on Finish to save
the results and to exit the questionnaire.

File Setup Test Edit Database Connectto Help

<o /0] 9H T4 == /20 AlQ)

Register | Detaik | Audiogiams  Questionnaiie |

| Responss | Question | Answer

Have any of pour blood relatives [Mather, Father, Sister(s) or Brother(s) only] had hearing loss prior to the age of 507

T no | Delete Finich
— Back

Patients: 5 |Records: 5 | Filker: Of | Sorted.

7.5.EDIT (CURRENTLY SELECTED) PATIENT RECORD

The purpose of this function is to enable the user to manually edit or amend a particular record, e.g. to change
the patient’s address or job description.

e Select the record by moving the arrowhead on the left side of the register page so that it is adjacent to the
required record. A.Iternatively, use Find \& to identify the required record.

e Click on Edit . and amend the appropriate fields.

e Click on Save H to save the changes.

7.6.DELETE A RECORD

The purpose of this function is to enable the user to delete a particular patient record or audiogram.

oy .
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7.6.1. DELETING AN AUDIOGRAM

Select the audiogram to be deleted by selecting the patient record on the Register page using the ‘*
arrows and then selecting the Audiogram tab. Choose the audiogram you wish to delete using the vertical
Sliding Selector at the centre of the window.

™
e Click on the Delete icon &
e Click Yes to confirm that you wish to delete the record

Alternatively use Find N (Section 7.7) to find a particular patient record and then select the audiogram you
wish to delete.

7.6.2. DELETING A COMPLETE PATIENT RECORD

This is achieved by either:
o Repeatedly deleting the separate audiograms contained within a patient record (see Section 7.6.1).
When the final audiogram is deleted the complete patient record is also deleted.
e Selecting Delete a Patient from the Edit menu. This will delete all the audiograms stored for the patient
and the patient details in a single operation.

Note: Use the Delete a Patient option with caution. The operation cannot be undone. It is recommended
that a back-up of the database is created first.

7.7.FIND A RECORD

The purpose of this function is to enable users to view an individual record or group of records based on one-
search criteria for a particular record parameter.

2

e Click on Find N and the dialogue box below will be displayed:
rﬂ Find a record Lér

Enter characters to search for

E—
Search Field

& Patient No. Lancel
" Sumame

" Forenames
" Position

" Department
™ Company
" TestDate

e Enter the search criteria in upper case text.

e Click on Find First. If one or more records exist that match the entered search criteria these will be identified
on the register page.

e Subsequent records that match the search criteria can be viewed by clicking on Find First.

7.8.SETTING FILTER CRITERIA

The purpose of this function is to enable users to create user defined reporting groups based on one or more
search parameters.

Click on Filter ] and the screen below will be displayed.

Eap > .

D-0116491-C (OMO016) — Audibase Operating Manual




D Database Filter EEE

Only records that zatisfy all these criteria will be displayed

Patient Wo.

| Company Current l—
Sumame Current l— Location Current l—
Forenarnes Current r— Examiner Current r—
Position Current l— Leaving Reason Currert l—
Department Current l— Status Current l—

yrz mnths wrz mnths
=t M Length of service between ’_ ’_ & ’_ I_
O or After Befare F1 Curent

Test Date Current ,7 Current ,7 F2 Cument ’7
Date of Birth Curent | [ Current Fa Cunent —
Prewvious Date Curent | [ Current ettt

D ate Joined Current ’7 Current ’7
Date Left Current ’7 Current ’7
Fecall Date Curent | [ Current

Current Becord Clear Filker Lpply Filker LCloze

E

Categorp 1 [~ 5TS

Category 2 [~ MIHL

Category 3

Category 4 [~ Data incomplete
Categore U [~ 4MNodata

i A A A

Enter the required database filter criteria, selecting if necessary any of the data from the current patient
selected by clicking Current next to the data boxes to include that data in the filter and click Apply Filter. All
records that meet the criteria will now be listed. To obtain a printout of this list select the Database Summary
option from Print (see Section 6.10).

To set up another filter, click Clear Filter and then enter the new search criteria.

When finished with the filter function, click Clear Filter followed by Close.

7.9.SORTING RECORDS

The purpose of this function is to enable users to view the presented audiometric records by a number of
record parameters.

A
Click on Sort Zl and the screen below will be displayed.

.
B Select which field to sort by

t

==
|
Patient Mo.

5 ot

@

~

" Sumame
~

~

~

~

Diate of Birth Caneel

Drate of Test
Previous Test

Category

Select the parameter by which you require the records to be sorted and click OK. The records will now be
presented according to your selection.
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7.10. CREATE AVERAGE FUNCTION

This function is designed to create an average for a user defined group of patients. When used with the filter
function to identify a defined group of patients, e.g. by company and test dates etc., successive annual
averages can be created to monitor overall average hearing levels for that group of individuals over a number
of user defined time periods.

7.11. EXIT FROM AUDIBASES

When you have completed all required tasks close the Audibase window in the usual way, or click on File and
then Exit from the main drop-down menu.

oy ;
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8. VISION MENU BAR FUNCTIONS

File Edit Database

Type

Selecting any of these functions will provide a drop-down menu with further options. Click on the option

required. For further information on the use of each option see the section listed below.

8.1.DROP-DOWN MENUS

File

Edit

Import

Export

Print Preview
Print

Add Patient
Insert Vision
Insert Audiogram
Edit

Save

Cancel Insert/Edit

Change Patient No.

Delete a Record
Delete a Patient

Database Find
Filter Criteria
Sort

Type Audiology
Vision

Eap >
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9.VISION TOOL BAR FUNCTIONS

The tool bar displays a number of function icons. When the mouse is positioned over an icon, a tooltip will
identify the function of the icon. To start the function, click the icon.

6.1 PREVIOUS PATIENT; NEXT PATIENT

é* These two functions enable the user to move between patient records, the arrowhead in the
first column of the register page showing which patient is currently selected.

6.2 NEW PATIENT

Click on this icon to enter Edit mode and to insert the details of a new patient into the
Patient’s Details page.

6.3 FIND
‘) Click this icon to search the database for a specific record.
N
6.4 SAVE
hl_i‘ Click this icon to save any changes to a patient’s records or test results.
6.5 FILTER
T Click this icon to bring up the filter function. Insert the search criteria and click Apply Filter
at the bottom of the screen. To select the current record only, click Current Record at the
bottom of the screen. Alternatively to search by one of the current patient’s criteria, click
Current next to the appropriate field. To clear the filter before using a different filter, click
Clear Filter.
6.6 SORT
A Use this icon to rearrange the order in which the database is presented on the Register
Il screen. Make the selection and click OK.

6.7 PRINT PREVIEW

|-| Click this icon to display the vision Print Preview screen. To print, click the printer icon found
in the top left hand corner of the screen.

—

%I To print directly without displaying the preview screen use File then Print from the menu
bar.

The printout will include basic patient details, vision test results for far, near, intermediate and perimeter tests
and if the patient has been referred or not.

6.8 EXPORT REGISTER DATA

'ﬁ' _ Use this icon to transfer the selected/displayed data as an electronic .csv (comma separated
L] variable) file into another application (e.g. Microsoft Excel).

Eap > .
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6.9 EDIT

Click this icon to enter Edit mode. Use this function to add details to or otherwise modify a
patient’s record and use the Save icon (see Section 9.4) to save the changes.

To cancel an edit, or if the changes are not required, select the Edit drop-down menu and then the Cancel

Insert/Edit option, or use the Cancel Insert/Edit @ toolbar button.

To amend an existing patient number, select the Edit drop-down menu and then the Change Patient Number
option. Complete the dialogue box as required.

6.10 INSERT VISION

:E Use this function to manually enter a patient’s vision details into the vision test screen.

6.11 DELETE RECORD

; Use this function to delete the currently selected vision test. To completely delete a patient’s
Y record, either delete each vision test separately or use the Delete a Patient option from the
Edit menu.

Note: Use the Delete a Patient option with caution. The operation cannot be undone. Itis recommended
that a back-up of the database is created first.

6.12 CANCEL INSERT/EDIT

Click this icon to cancel an insertion, or to discard changes if they are not required. The
functionality is exactly the same as using the Edit drop-down menu and then the Cancel
Insert/Edit option as described in section 9.9.

6.13 SWITCH TO AUDIOLOGY MODE

{) Click this icon to switch from vision mode to audiology mode. Please refer to sections 5-7
r for full details on Audibase audiology mode functionality.

Eap > .
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10. THE MAIN VISION SCREENS

10.1. THE REGISTER SCREEN

[ ) Vision Test [ LR0OL, Laura Right, on 16/04/2015 E

Eile Edit Database Type
] Ty | B ; ] &
@ A1 T3 /=T Q9
{Register | Detals | Vision Test|
Patient No Sumame Forenames Last Test| Time of Test| Previous Test Date of Birth| Position/Rank. Dept/Unit Company
» [LROOT Right Laura 1E/04/2015) ol 21/07/1978| Publishing Binding UK Publishing
PROD1 Fiogoers Paul 16/04/2015] 14:45:22] 01/05/1345| - - -
KGO01 Game Kelly 16/04/2015] 14:45:11 09/09/1987| -
JHOOT James Henry 16/04/2015) 14:48:57] 03/03/1975]-
< | 3
Patients: £ |Records: 4 | Filter: OFf | Sorted:

This screen when populated will show details of each patient. Use the left and right arrows at the top left hand
side of the screen to select a patient.

10.2. THE DETAILS PAGE

Either click on the New Patient Ij icon or click on the Details tab (if patient data is already loaded) to access
the Details page below:

[ E] Vision Test [ LR0OL, Laura Right, on 16/04/2015 52‘
File Edit Database Type
oo DA T4 |=E /=2 Q9
F4 4] = e
Register | Detals | Wision Test |
rLatest Data
- Patient - Aeldr r Test
Patient Mo [LRoOm [Gillinghamm Strest Instrument Type  [Timus -
Sumame [Right [Landan Dateof Test  [16/04/2015
Forenames [Lawra [Victoria Time of Test — [15,00.01
Postion/ank — [Fublihing | [Greater London Previous Test [ )7
Department/Unit Igmdmg LI |gw1\: 1P5 Exanniner UH -
Company [UK Publishing -] [ Serial No. [oom =
Location [Fondon =l Glasses & Yes (N
Date of Bith ELE e Contact Lenses  ( Yes (4 Mo
" Male & Female Lasieees 16/08/2005 Type of Glasses INolma\ -
Status F =] || e W ChangeinfX O Yes & No
LeavingRezson |- = Length of Service [Gyr 10mnihs LastExamby  [G1/03/208
Doctor
[he RecalDale  [Ti7m6/2016
[~ User Defined Fields
= =
| EN; =
Patients: 5 |Records: 4 | Fier: Off | Soted:

Details may be added and/or edited for each patient as required. Ensure that for each patient a unique patient

identifier number is used.
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Note that Audibase automatically fills in several boxes in the Test area. They are:

e The box labelled Examiner if a “Username” has been entered on the password screen (see Section
4).
e The boxes labelled Date of Test and Time of Test when a record is saved in Audibase.

Only enter data in the Date of Test and Time of Test fields if a previously manually recorded vision test is being
entered into Audibase and you wish to preserve the date and time of that test.

10.3. EDITING DROP-DOWN MENUS ON THE DETAILS PAGE

To facilitate data entry, commonly used items may be selected via drop-down menus. These include the entries
for “Company”, “Position” and “Leaving Reason” and are displayed on the Details page with a down arrow at
the right of the data input box.

The contents of these drop-down menus may be defined by the user.
To edit the contents of a drop down menu, please refer to section 7.3.
The fields applicable exclusively to Audibase vision are “Instrument Type” (vinstrument) and “Serial No.”

(vserial). Others are shared between Vision and Audiology mode, excluding “Print Report Title” which is
exclusively for Audiology mode.

Test

Instrurment Type || j
Diate of Test ||Hmis — |
Time of Test ,j

Previous Test ,E

Examiner | j
Serial Mo. I—L|
Glasses " Yex O Mo

ContactLenses € Yes (Mo
Type of Glasses  |Momal -

Change in R " Yes Mo

Laszt Exarn by 4

Doctor

Recall Date _

Eap > ;
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10.4. THE VISION TEST PAGE

Select the Vision Test tab as shown below:

-
IED Vision Test [ LROOL, Laura Right, on 16/04/2015 ] lF- EER g
| File Edit Datsbase Type
‘ Ly [ 3 — )
e A H THeE /=T Q9
Zv |==y| === 1Y) L
Fiegister | Detalls  Vision Test I
Far Vision Test No: 1 of 1 16/04/2015 15:00:01 -

‘Hnw rmany cubes do you see?

Slide 1 - Binocular Vision

" Four & Two (" Three

[The two white cubes should fuse together for a patient with good binocular vision
{4 PASS response is 'three’ or 'four, then three' cubes.
b4 FAIL response is four' or 'two' cubes

| Mext ‘ b |

Fatients: & Records: 4 Filter: Off Soited:

If required, another previously recorded vision test can be manually entered when the insert vision functionality
is used (refer to section 9.10). See below for an example:

a1
] Vision Test [ LROOL, Laura Right, on 16/04/2015 | (i o0 |

Eile Edit Database Type

0 2 L Al = , ] @
3 Xz AT Ky
o QM T4 e 2-=]E ;
Reegister | Detals Vision Test |
Edit Mode
Far Vision TestMo: 1 of 1 16/04/201515:00:01 .

‘Hnw many cubes do you see?

[The two white cubes should fuse together for a patient with good binocular vision
&4 PASS response is 'three' or four, then three' cubes
b4 FAIL response is four' or 'two' cubes

Next b |

Patients: B Records: 4 Filter: Off Sorted:

Each test screen follows the same format:

e Test distance (far, near, intermediate or peripheral), test record number for the patient and
associated test date and time.

e Instructions for the particular test.

e A picture of the slide currently being tested.

o Radio buttons/check boxes to record the patient response (intermediate test distance also includes
radio buttons to record the distance tested).

e Pass/fail criteria for the test.

e Patient response and navigation buttons.
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When entering details of a vision test, select the radio buttons or check boxes to indicate the patients response.
To advance to the next test page select the Next button or to return to a previous test page select the Previous
button. When on the last test page, select the save toolbar icon or Edit->Save from the menu to save the vision

test.

When performing an acuity or depth perception test, the Pass and Fail buttons can be used to record patient
responses. For each correct response select Pass and for each incorrect response Fail. Using these buttons
will automatically advance the operator to the next test page when the pass fail criteria have been met. The
Clear Test button clears all responses input for that particular test screen.

Pass ‘ Eail ‘ LClear Test

Patients: B Records: 4 Filter: Off Sorted:

The order of the vision test pages is as follows:

Example of the vision test screens are shown below.

Far Vision — Binocular Vision

Far Vision — Acuity Both Eyes

Far Vision — Acuity Right Eye

Far Vision — Acuity Left Eye

Far Vision — Depth Perception

Far Vision — Colour Perception

Far Vision — Vertical Phoria

Far Vision — Lateral Phoria

Near Vision — Binocular Vision

Near Vision — Acuity Both Eyes

Near Vision — Acuity Right Eye

Near Vision — Acuity Left Eye

Near Vision — Vertical Phoria

Near Vision — Lateral Phoria
Intermediate Vision — Acuity Both Eyes
Intermediate Vision — Acuity Right Eye
Intermediate Vision — Acuity Left Eye
Peripheral Vision

E v
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Binocular Vision:

File Edit Database Type

CEINEGE R AN

Reegister | Detals Viion Test |

,.:E‘.«.
3]

Q

Test No: 1 of 1 16/04/2015 15:00:01

Far Vision

‘How marty cubes do you see?

Slide 1 - Binocular Yision

" Four & Two ( Three

[The two white cubes should fuse together for a patient with good binocular vision
b4 PASS response is 'three' or four, then three' cubes
b4 FAIL response is four' or 'two' cubes

Nest b |

|4

Patients: B Records: 4 Filter: Off Sorted:

Acuity:

Eile Edit Database Type

EINENER ™

Reegister | Detals Vision Test |

==

| /=2 &

Test No: 1 of 1 16/04/2015 15:00:01

Far Vision

‘Stamng with smallest target wou can see. what is the postion of the unbroken ring? Top, Battom, Left or Right?

1 2 3 4 5 E 7 g 8 o 1 12 13 14
T R R L T B L R L B R B T R
F ¥ ¥V ¥ ¥ F ¥ ¥V ¥V ¥ ¥V ¥ I
] & ] & & & & & & & B & B ]
g0 30 A % @2 W5 9 75 6E & 55 5 45 4

’A Fail iz when the patient misses two consecutive targets. or cannot see the target clearly Then the last acuity corectly seen is recorded

Pass ‘ Fail | LClear Test
Previous

Next ‘ b |

|4

Patients: B Records: 4 Filter: Off Sorted:
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Depth Perce tion

n Test

Eile Edit Database Type

1 V2™ /==E @
\ X3 |\ 4= !
oo A M T4 &= =
Reegister | Detals Vision Test |
Far Vision TestMo: 1 of 1 16/04/201515:00:01

‘Fnr each target, identify which ring seems ta float out towards you?

Slide 5 - Depth Perception

mtl_.
g~
m?lm

4
W~
T

—g o
-3 ™
B
—3% =
2w

(Once the Patient misses 2 consecutive targets or cannot see the target clearly. the last correct reading is recorded.
Reading all circles correctly through to 9 is normal depth perception
mything bielow b is unacceptable

Pass Fail Clear Test

Previous Next

|4

Patients: £ |Records: 4 | Filter: OFf | Sorted:

Colour Perce

Eile Edit Database Type

Qo AIM TH =™ /=T QP
- Xz /= 1 Ryl
o DA T8 /=S
Fiegister | Detalls  Vision Test |
Far Vision Test No: 1 of 1 16/04/2015 15:00:01 -
Mhat numbers do you see in circles A, B, C etc?

Slide 6 - Colour Perception

& B © D E F
M1vW2 W5 W2WE [WE [W1WE [ MNone

[There are atatal of 8 numerals, hutcircle Fis blank.
Mormal: Correct reading of ALL & numerals

Mild Deficiency: Correct reading of atleast 5 numerals
Fail: Inshility to read atleast b numerals

Previous Next

|4

Paients. 6 |Records: 4 [Filter, Off [Sorted
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Vertical Phoria:

Eile Edit Database Type

L JINIENY = [ 5051

Reegister | Detals Vision Test |

Far Vision Test No: 1 of 1 16/04/2015 15:00:01

Fhmugh the round part of which musical note does the red line pass?

Slide 7 - Vertical Phoria

1 12 2 23 3 34 4
rrr N r

i
o
=)
ki
E

A=
T
1
i
-
=

Emewhere from 2.5 t0 5.5 is the accepted norm.
mewhere from 1 to 4 indicates left hyperpharia,
mewhere from 4 ta 7 indicates right lyperphoria.

Previous

Next

a1
] Vision Test [ LROOL, Laura Right, on 16/04/2015 | (i o0 |

|4

Patients: B Records: 4 Filter: Off Sorted:

Lateral Phoria:

Eile Edit Database Type

oL JINIENY = [ 4P A

Fiegister | Detalls  Vision Test I

Far Vision Test No: 1 of 1 16/04/2015 15:00:01

Fhe arrowe points to which musical note?

Slide 8 - Lateral Phoria

112 2 23 3 34 4 45 5 &6 67 7a 8
- rr r r r

&

a
r

LU

[
-

prrow pointing to 8 is ideal. between 3.510 12.5 is the accepted norm.
prrow between 1 and & indicates Esophoaria (one eve tums inward compared to the other)
prrow between 8 and 15 indicates Exaphoria (one eye tums outward compared to the other)

Previous

Next

3
] Vision Test [ LROOL, Laura Right, on 16/04/2015 | (o =0 |

|4

Patients: B Records: 4 Filker: Off Soited:
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Peripheral Vision Test:

,

Eile Edit Database Type
- 1 A Ty | 4 —1] @ )
4 X AT
e L JINIENY = 45T == :
Reegister | Detals Vision Test |
Peripheral ¥ision Test No: 1 of 1 16/04/2015 15:00:01 -

‘Lnnk ahead atthe the test slide. Do you see a lightflashing?

Peripheral Vision Test

Right Left

%5 70 55 45° Total i 45° Total Total
T " ™ Nasal [V 130 I " Nasal [ 130 BathEyes  [260

Selectthe lamp to be illuminated. Record the answer for each lamp.A fail is the patient missing any lamps.
Some Restriction: Fail at 85°

Severe Restriction: FAIL &t 707 or 55°

MNasal Restriction: FAIL at M 45°

10.5. EDIT (CURRENTLY SELECTED) PATIENT RECORD

The purpose of this function is to enable the user to manually edit or amend a particular record, e.g. to change
the patient’s address or job description.

e Select the record by moving the arrowhead on the left side of the register page so that it is adjacent to the

»

required record. Alternatively, use Find \"\ to identify the required record.
e Click on Edit and amend the appropriate fields.

| l‘
e Click on Save k to save the changes.

10.6. DELETE A RECORD

The purpose of this function is to enable the user to delete a particular patient record or vision test.

10.6.1. DELETING A VISION TEST

Select the vision test to be deleted by selecting the patient record on the Register page using the ‘*
arrows and then selecting the Vision Test tab. Choose the vision test you wish to delete using the vertical
Sliding Selector at the right of the window.

——]

| N
e Click on the Delete icon &
e Click Yes to confirm that you wish to delete the record

2

Alternatively use Find \"'\ (Section 10.7) to find a particular patient record and then select the vision test you
wish to delete.

oy ;
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10.6.2. DELETING A COMPLETE PATIENT RECORD

This is achieved by either:
o Repeatedly deleting the separate vision tests contained within a patient record (see Section 10.6.1).
When the final vision test is deleted the complete patient record is also deleted.
e Selecting Delete Patient from the Edit menu. This will delete all the vision tests stored for the patient
and the patient details in a single operation.

Note: Use the Delete Patient option with caution. The operation cannot be undone. It is recommended
that a back-up of the database is created first.

10.7. FIND A RECORD

The purpose of this function is to enable users to view an individual record or group of records based on one-
search criteria for a particular record parameter.

e Click on Find N and the dialogue box below will be displayed:
rﬂ Find a record [é]

Enter characters to search for

B
Search Field

& Patient Mo. LCancel
" Sumame

" Forenames
" Position

i Departrent
™ Company
" TestDate

e Enter the search criteria in upper case text.

e Click on Find First. If one or more records exist that match the entered search criteria these will be identified
on the register page.

e Subsequent records that match the search criteria can be viewed by clicking on Find First.

10.8. SETTING FILTER CRITERIA

The purpose of this function is to enable users to create user defined reporting groups based on one or more
search parameters.

Click on Filter ] and the screen below will be displayed.

Eap > .
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B .~ -

Only records that satizfy all these criteria will be displayed

Company Current
Location Current
Examiner Current
Leaving Reason Current
Status Current

Length of service between

Patient No. |

Surname Current ’—
Forenames Current l—
Pasition Current ,—
Department Current ’—

Sex Current ’—

Oror After
TestDate Curent | [ Current
Date of Birth Curent | [ Current
Prewious Date Curent | [ Currert
Date Joined Curent | [ Current
Date Left Curent | [ Current
Recall Date Curent ’7 Current
Current Becard Clear Filter Apply Filker

Before F1

F2
F3
Ii

——

—
——

vz mnths ws  mhths

e r

Current
Current
Current

LCloze

Enter the required database filter criteria, selecting if necessary any of the data from the current patient
selected by clicking Current next to the data boxes to include that data in the filter and click Apply Filter. All
records that meet the criteria will now be listed.

To set up another filter, click Clear Filter and then enter the new search criteria.

When finished with the filter function, click Clear Filter followed by Close.

10.9.

SORTING RECORDS

The purpose of this function is to enable users to view the presented vision test records by a number of record

parameters.

A
Click on Sort Zl and the screen below will be displayed.

ED Select which field to sort by

~
-
~
~
-
~

Sort

Patient Mo.
Surname
[Drate of Birth
Drate of Test
Previous Test

Category

LCancel

[Fo)
e

Select the parameter by which you require the records to be sorted and click OK. The records will now be

presented according to your selection.
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10.10. EXIT FROM AUDIBASES

When you have completed all required tasks close the Audibase vision and Audibase audiology windows in
the usual way, or switch from vision mode to audiogram mode and then click on File and then Exit from the

main drop-down menu.

oy ;
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11. UNINSTALLING THE AUDIBASES.5 PROGRAM

This may be carried out in the usual way from Program and Features in the Control Panel. Select Audibase5.5
and click on Uninstall/Change (Windows 7 navigation). Audibase5.5 and all related programs will be removed
from your hard drive. After the uninstall operation the database “audibase5.mdb” and any exported “.csv” files
remain for future use. If required they may be deleted separately.

12. UPGRADING FROM AUDIBASES3, 4,5,5.2,5.30R5.4
TO AUDIBASES.5

Audibase4, Audibase5, Audibase5.2 Audibase5.3 and Audibase5.4 may be upgraded as described in Section
3. On starting Audibase5.5 after the upgrade an error message will be generated as the existing database is
loaded. Close the dialogue box, then exit from and re-start Audibase5.5.

Audibase3 is now no longer supported, but the facility to import a legacy database created with Audibase3 is
included within Audibase5.5. However it is first necessary to export the data from Audibase3 in a prescribed
manner, and thus the Audibase3 software must still be available.

For further details of performing this operation please refer to Appendix 9.

Eap > .
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13. IMPORTING RECORDS INTO AUDIBASES.5

This function assumes that a .csv database file with the correct format is available for import. Such a file would
typically have been previously exported from Audibase (for example as a backup) or exported from the
CA850/4 or CA850/5 audiometer (refer to the operating manual for this audiometer). In both cases the default
name of the exported file is “Exportdata.csv’.

From within Audiology mode, select File — Import — Import File from the main menu. The dialogue box shown
below will appear.

Organize * Mew folder =~ [ '@'

Bl Desktop 0 Name Date modified Type
Downloads —

< L) Exportdata.csv 15/08/2013 14:43 Microsoft Excel C...
v+ Dropbox

= Recent Places

o Libraries
3 Documents
J‘. Music
le=| Pictures

B videos

M Computer
&, 0sWin7 (C)
ca Windows 8 (E)

- 4 1] | +

File name: - ’ Exported file VI

[ open v [ cance |

Navigate to the correct folder, select the required file and click Open. The data will then be imported into
Audibase. If a duplicate record is found (based on the Patient Number and the date/time of the test) an error
message will be displayed:

f Error lihj‘

This record already exists in the database. Pat No:DET-TAB Date of Test:
13/03/2012 Date of Test: 11:53:01

The duplicate data will not be imported.

It is also possible to import a vision test csv file. Again, this assumes that a .csv database file with the correct
format is available for import. Such a file would have been previously exported from Audibase vision (for
example as a backup). The default name of the exported vison file is “ExportVisionData.csv”. The vision import
process is the same as audiology, except you select File — Import — Import File from the main menu in vision
mode.

oy .
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14. ERROR MESSAGES

Any system errors or problems will normally generate an on screen error message with an error number. If the
problem persists please email a copy of the file “err.log” to your distributor (or directly to Amplivox if the product
was purchased directly) for advice. This file is located in the Audibase5.5 installation directory (e.g. Program
Files/Audibase5/err.log if default settings were used for installation — refer to Section 3).

oy :
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APPENDIX 1: INSTALLATION TROUBLESHOOTING

In the majority of cases installation of the Audibase software and device drivers should be a straightforward
process. However, if you do encounter a problem this appendix may help to resolve it.

A.1.1 USB Serial Port Device Driver Failed to Install (not CA850/4)

Please refer to the troubleshooting section of OM032, the Amplivox Operating Manual for USB Driver
Installation.

A.1.2 Device Drivers

It is important to ensure that the latest device drivers are used, especially if a previous Amplivox device driver
has been installed. This is likely to be the case if the PC has been used previously with an Amplivox
audiometer.

If this is the case AND the procedure described in Section 3.2.2 is not carried out automatically then the
following should be done

A.1.2.1 CA850/4 Audiometer

With the CA850/4 connected and switched on use Windows Control Panel, then System — Device Manager
(Windows 7 navigation) to display devices listed under “Ports (COM & LPT)".

File Action View Help

&=z | FE HF & Fss

? USB Serial Port (COM3)

b -%| Sound, video and game controllers

{8 System devices

a- ﬂ Universal Serial Bus controllers

a Intel(R) ICHS Family USE Universal Host Controller - 2934
a Intel(R) ICHS Family USE Universal Host Controller - 2935
a Intel(R) ICH3 Family USE Universal Host Controller - 2936
a Intel(R]) ICH3 Family USE Universal Host Controller - 2937
a Intel(R) ICH3 Family USE Universal Host Controller - 2938
a Intel(R) ICH3 Family USE Universal Host Controller - 2939
a Intel(R) ICH3 Family USB2 Enhanced Host Controller - 2934
a Intel(R) ICH3 Family USB2 Enhanced Host Controller - 203C
a USB Composite Device

§ USB Root Hub

@ USB Root Hub

@ USB Root Hub

§ USB Reot Hub

§ USB Reot Hub

§ USB Root Hub

§ USB Root Hub

§ USB Root Hub

a USB Serial Converter

Right click on the port assigned to the audiometer (COM3 in the example above) and select the “Update Driver
...” option. Refer to OM032 the Amplivox Operating Manual for USB Driver Installation to update the driver.

If the driver is already the latest version the following window will be displayed:

oy :
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K% _ Update Driver Software - USE Serial Port (COM3)

The best driver software for your device is already installed
Windows has determined the driver software for your device is up to date.

USB Serial Port

Click on Close to conclude the operation.
A.1.2.2 Audiometers Other than CA850/4

With the audiometer connected and switched on (if applicable) use Windows Control Panel, then System —
Device Manager (Windows 7 navigation) to display devices listed under “Universal Serial Bus controllers”:

File Action View Help
&= @ HEl

1> -8 Computer

|:> - Disk drives

[ ‘a', Display adapters
> -4 DVD/CD-ROM drives
> -Cg IDE ATA/ATAPI controllers
» - Imaging devices
b-EB Keyboards
L ﬂ Mice and other pointing devices
L l_-_'J Menitors
b -F Network adapters
» Y3 Ports (COM & LPT)
b R Processaors
L -%) Sound, video and game controllers
.--;.;JSste' =
Universal Serial Bus controllers
2 Audiological Instrument
i Intel(R) ICHS Family USE Universal Host Controller -
i Intel(R) ICHS Family USB Universal Host Controller -
i Intel(R) ICH3 Family USE Universal Host Controller -
i Intel(R) ICH3 Family USB Universal Host Controller -
¥

Intel(R} ICH3 Family USB Universal Host Controller -

Right click on “Audiological Instrument” and select the “Update Driver ...” option. Refer to OM032 the Amplivox
Operating Manual for USB Driver Installation to update the driver.

If the driver is already the latest version the following window will be displayed:
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The best driver software for your device is already installed
Windows has determined the driver software for your device is up to date.

Audiological Instrument

e

Click on Close to conclude the operation.

A.1.3 Use of Alternative Audiometer Types

If it is required to use a CA850 Series 4 audiometer for the first time having previously used a 116, 170, PC850
(USB variant), Otosure or CA850 Series 5 audiometer then additional drivers will be needed. The user should
be prompted to install these when the CA850/4 has been connected to the PC. Refer also to Appendix 3.

A similar process is required if a 116, 170, PC850, Otosure or CA850 Series 5 audiometer is to be used for
the first time having previously only used a CA850 Series 4 audiometer.

A.1.4 Audiometer not Connected

If Audibase attempts to communicate with an audiometer when none have been connected the following error
will be displayed:

—,. 3
Communication

Instrument not found

Error 2 type d

Click on OK to close the error box. Then select the Edit drop-down menu and use the Cancel Insert/Edit option
or use the Cancel Insert/Edit toolbar button.

Connect the required audiometer and repeat the operation.
A.1.5 Audiometer is not Switched On

If Audibase tries to communicate with an audiometer that is not switched on (if applicable) the following error

will be displayed:
@ 55
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Instrument not found

Error 2 type d

Click on OK to close the error box. Then select the Edit drop-down menu and use the Cancel Insert/Edit option
or use the Cancel Insert/Edit toolbar button.

Switch on the audiometer and repeat the operation.
A.1.6 No Test Results

If no test results are obtained from an audiometer (e.g. after closing the PC850 program or other
communications problem) the following error will be displayed:

r N
Instrument Error ld—?-J

No results
Ampdata file not found. , 100A

There may be a delay of a few seconds before the above message appears.

Click on OK to close the error box. Then select the Edit drop-down menu and use the Cancel Insert/Edit option
or use the Cancel Insert/Edit toolbar button.

Ensure that the audiometer is connected and switched on (if applicable) then repeat the operation.

Note: A similar message (below) will always display if the user exits Otosure, PC850 or any other
communications program without any test results, and these messages should not be confused.

r ~
Instrument Error @

Mo results: (153}

oy .
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APPENDIX 2: USING THE CA850 SERIES 3 AUDIOMETER

A2.1 Introduction

The Amplivox CA850/3 may be connected to a PC with the Audibase application installed to allow the transfer
of data from the audiometer.

A2.2 Connection and Configuration

Install and Register Audibase as described in Sections 3 & 4.

Connect the audiometer to the PC. This would normally be to a spare USB port on the PC using USB Serial
Adapter (Amplivox stock number L04).

Identify the COM Number of the USB Serial Port assigned by using Windows Control Panel, then System —
Device Manager (Windows 7 navigation) and inspecting the devices listed under “Ports (COM & LPT)".

o

File Action View Help

&= | T B HE & B Kb

> -iM Computer

b= Disk drives
» - B Display adapters
-4 DVD/CD-ROM drives
> g IDE ATA/ATAPI controllers
b %5 Imaging devices
b Keyboards
b }E!, Mice and other pointing devices
» B Monitors
b8P N
orts (COM & LPT)

b -% Sound, video and game controllers
> -yM System devices

- a Universal Serial Bus controllers

In the example above, COML1 has been assigned as the USB serial port using the USB Serial Adapter (L04).
Windows Control Panel may then be closed.

Open Audibase and select ‘Setup’ — ‘Configuration’ (or click on the ‘Configure’ shortcut icon in the toolbar)
and then select the ‘Connection’ tab.

ED Configuration @

=
LCancel

Backup/Repair | Databaze Setup] Questionnaire | Test Analysis  Cornection | Patient Options

For connection to CAB50 Audibase audiometers please use this screen.

CABS0 Port

r o5 IW Delay between exported records
g4 D.5I ) I13
o 53

oy .
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Click on the S3 option and then use the drop-down option under “Port” to select the COM port assigned (COM1
in the example above).

The “Delay between exported records” slide bar should initially be left at 0.5 seconds. However depending on
the specific system configurations it may be necessary to increase this delay to ensure the data is transferred
completely.

Note that when the configuration menu is accessed it must be exited using the ‘OK’ button (do not
close the box using cancel or the close button) or no changes will be made.

A2.3 Transferring Data

Refer to the CA850/3 user manual for details of how to transfer the audiometric data.

oy :
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APPENDIX 3: USING THE CA850 SERIES 4 AUDIOMETER

A3.1 Introduction

The Amplivox CA850/4 may be connected to a PC with the Audibase application installed to allow the transfer
of data from the audiometer into Audibase.

This process is only required for single-record transfer of data between the CA850 Series 4 and a PC via a
lead connecting the audiometer to a USB port on the PC. Users are reminded that a faster and more convenient
means of data transfer between the audiometer and PC can be achieved by means of a USB drive (memory
stick). Refer to the CA850/4 operating manual for details of this procedure.

A3.2 Driver Installation Process

To enable the single-record data transfer a “USB Serial Port” device driver needs to be installed on the PC.
The installation of this driver will be requested when the CA850/4 is plugged into the PC.

It is then necessary to ensure that Audibase is configured to use the “COM Number” allocated by the PC to
this port. The procedure for doing this is described below and may need to be repeated if the audiometer is re-
connected. It is recommended that the same USB port on the PC is always used to connect the CA850/4
audiometer.

Turn on the CA850/4 and connect the supplied USB cable between the “USB-PC” connection on the
audiometer and a spare USB port on the PC. A message will appear on the PC when the new hardware is
detected.

Follow the driver installation procedure in OM032 the Amplivox Operating Manual for USB Driver Installation.

A3.3 Configuration of Audibase

Identify the COM Number of the USB Serial Port assigned by using Windows Control Panel, then System —
Device Manager (Windows 7 navigation) and inspecting the devices listed under “Ports (COM & LPT)".

Eap > .
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File Action View Help

= 5 E BHE 8 %S

? USB Serial Port (COM3)

! -% Sound, video and game controllers

! M System devices

- a Universal Serial Bus controllers

i USB Composite Device
§ USB Reot Hub

§ USB Root Hub

§ USB Root Hub

§ USB Root Hub

§ USB Root Hub

§ USB Root Hub

§ USB Root Hub

§ USB Root Hub

a USB Serial Converter

E Intel(R) ICH3 Family USE Universal Host Controller -
E Intel(R) ICH3 Family USE Universal Host Controller -
E Intel(R) ICH3 Family USB Universal Host Controller -
s Intel(R) ICH3 Family USB Universal Host Controller -
s Intel(R) ICH3 Family USE Universal Host Controller -
a Intel(R) ICHS Family USE Universal Host Controller -
i Intel(R) ICHY Family USB2 Enhanced Host Controller - 2034
i Intel(R) ICHS Family USB2 Enhanced Host Controller - 293C

2934
2935
2936
2937
2938
2939

In the example above, COM3 has been assigned as the USB serial port.

closed.

Windows Control Panel may then be

In Audibase5.5 select ‘Setup — Configuration’ (or click on the ‘Configure’ shortcut icon in the toolbar) and then

select the ‘Connection’ tab.

-
B Configuration

CaBs0 Fort

v 54

" 53

- COM 3 [available) -

Far connection to CABS0 Audibaze audiometers pleaze uze this screen.

Delay between exported records

Backup/Repair | Database Setup] Questionnaine | TestAnalyziz  Connection | Patient Options

—

05

1z

LCancel

LE g

Click on the S4 option and then use the drop-down option under “Port” to select the COM port assigned (COM3

in the example above).

Note that when the configuration menu is accessed it must be exited using the ‘OK’ button (do not
close the box using cancel or the close button) or no changes will be made.
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A3.4 Importing Data into Audibase

Select ‘Connect to’ and then click on ‘Import from CA850’.

F-) Audibase 5.5 [ BOOTH_MAX, Max - on 21/05/2012 ] [B + 1[BL Right:

File Setup Test Edit Database | Connectto | Help
“‘ D Import fram CA850 I, ‘
Export to CAS50 l:!lu

lDetalIs] Audlograms] Questlonnalre]

|’§

@

[

The following window is displayed:

File Setup Test Edit Database Connectto Help
)2 Yl =-RCE
(T AT ’ b
<«w A0 41 SAQ e
Fiegister 1 Deta\\s} Audmglams} Uuastmnnaue]
Patient Mo [Sumame Forenames Last Test| Timeaof Test] Previous Test Date of Birth| Categorisation Position/Rank 5]
P |BOOTH_MAX - taw 2140572012, 10:55:03 28/07/1984|HSE: 1 4-no data - -
BOOTH_RHS Black Rachel 2140672012 10:38:51 01/01/1975/HSE: 1 4-no data -
BOOTH_PR Fioggers Paul 2|HSE: 1 4-no data - -
BOOTH_H Hery James | B Import from CASSD 54 s Frariee o o Qualty i
WJHOO1 Heniy James F3[HSE: 1 Quality Engineer [il
Lines of data in buffer
Configure iew
Choose 'R5232 Export’ from the Series 4 audiometer,
‘ Stare LCancel
| »
Patients: 5 Records: 5 Filter: Off Sorted:

Return to the CA850 Series 4 and select the function key adjacent to ‘RS232 export’ (this is found within the
‘Test’ mode). Note: models of the CA850 Series 4 with serial number greater than 16060 use the term ‘Data
export’ for this function. This operation will save the current test record to the Audibase application. Return to
the Audibase screen and after a few seconds the ‘Lines of data in buffer’ text box on Audibase will show ‘1°.
This data can be viewed by clicking on the “View’ button if required.

To save the data to the database, click on the ‘Store’ button. The confirmation message ‘Are you sure?’ will
appear, followed by a message to report if the save was successful. For example, if the Patient Number, Test
Date and Test Time are the same as a record that already exists in the database, the import is considered a
duplicate and will be rejected.

A3.5 Disconnection and Reconnection of Audiometer

If the audiometer is disconnected from the PC it is possible that an alternative COM Number will be assigned
when it is subsequently reconnected, especially if connected to a different USB port to that originally used. If
this is the case the following warning will be displayed:

oy .

D-0116491-C (OMO016) — Audibase Operating Manual




r Y
Warning CA850 connection @&_J

Unavailable comm port. Please select a different comm port from the connection
tab in the configuration window, and check cable is plugged in.

Audibase5.5 will need to be configured with the correct COM Number to allow data transfer from the
audiometer to the PC, and the procedures outlined in Section A3.3 should be repeated to identify the correct
COM Number for use with Audibase5.5.

If Audibase is started without the audiometer connected, the warning message above may be displayed. Click
on OK to continue using Audibase, but remember that the audiometer will need connecting and/or configuring
before data transfer can be performed.

To suppress this message (for example if an alternative audiometer is to be used for an extended period) the
“COM -” port may be selected from the Configuration — Connection screen as shown below:

-
B) Configuration

Backup/Repair | Databaze Setup] Questionnaire | Test Analysis  Connection | Patient Options

For connection to CA850 Audibasze audiometers please uge this screen.

LCancel

[9CH |

Cag50 Part
~ o5 o = Delay between exported records
+ 54 05 1s
" 53

Remember that the appropriate COM port will need to be selected before data transfer from the CA850/4 can
again be performed.

Note that when the configuration menu is accessed it must be exited using the ‘OK’ button (do not
close the box using cancel or the close button) or no changes will be made.

A3.6 Updating the Device Drivers

If the CA850/4 was already in use before this version of Audibase5.5 was installed then it is recommended
that the USB Serial Port device driver is updated.

Please refer to Appendix Al1.2 for further details.
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APPENDIX 4: USING THE CA850 SERIES 5 AUDIOMETER

A4.1 Introduction

The Amplivox CA850/5 may be connected to a PC with the Audibase application installed to allow the transfer
of data from the audiometer into Audibase.

This process is only required for single-record transfer of data between the CA850 Series 5 and a PC via a
lead connecting the audiometer to a USB port on the PC. Users are reminded that a faster and more convenient
means of data transfer between the audiometer and PC can be achieved by means of a USB drive (memory
stick). Refer to the CA850/5 operating manual for details of this procedure.

A4.2 Driver Installation Process

To enable the single-record data transfer, the Amplivox USB drivers need to be installed on the PC. The
installation of this driver will be requested when the CA850/5 is connected to the PC. Please refer to OM032
the Amplivox Operating Manual for USB Driver Installation.

It is then necessary to ensure that Audibase is configured to use the “COM Number” allocated by the PC to
this port. The procedure for doing this is described below and may need to be repeated if the audiometer is re-
connected.

A4.3 Configuration of Audibase

Identify the COM Number of the USB Serial Port assigned by using Windows Control Panel, then System —
Device Manager (Windows 7 navigation) and inspecting the devices listed under “Ports (COM & LPT)".

File  Action View Help
a5 HE HE 8 F&Y

» B Display adapters

> 4} DVD/CD-ROM drives

> g IDE ATA/ATAPI controllers

» 4 Imaging devices

bED Keyboards

b jﬂ Mice and other pointing devices
b B Monitors

5 A Metwork adapters

s L -

b -%| Sound, video and game controllers

» {8 System devices

4. @ Universal Serial Bus controllers
§ Audiclogical Instrument
- ¢ Intel(R) ICHY Family USE Universal Host Controller - 2034

- g Intel(R) ICH3 Family USE Universal Host Controller - 2835

i i Intel(R) ICHY Family USB Universal Host Controller - 2936

In the example above, COM3 has been assigned as the USB Serial Port. Windows Control Panel may then
be closed.

In Audibase5.5 select ‘Setup — Configuration’ (or click on the ‘Configure’ shortcut icon in the toolbar) and then
select the ‘Connection’ tab.
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r - B
B Configuration . M

Backup/Repair | Database Setupl Questionnaire | Test Analyziz  Connection | Patient Options

LCancel |

Far connection to CABS0 Audibaze audiometers pleaze uze this screen.

Cagsl—— Fort
Delay between exported records
@ 55 [EOM 3 (available) -| —_—
54 0.5 1s
53

Click on the S5 option and then use the drop-down option under “Port” to select the COM port assigned (COM3
in the example above).

Note that when the configuration menu is accessed it must be exited using the ‘OK’ button (do not
close the box using cancel or the close button) or no changes will be made.

A4.4 Importing Data into Audibase

Select ‘Connect to’ and then click on ‘Import from CA850’.

| ) Audibase 5.5 BOOTF

File Setup Test Edit Database [Connectto Help

Import from CAB50 ; = ] Y -
<« gl - ||| /=T A Q@
Export to CAS50 ] — 7 b
| Detailsl Audiogramsl Questionnaire |
The following window is displayed:
a == =
File Setup Test Edit Database Connectto Help
DIAI0] 9 b Vil /E Al Q)
) et 74 |x2 [T 3 A .
<o N 0] 9k 21 i) - ®
Fiegister | Deta\\sl Audmglamsl Uuastmnnauel
Patient Mo [Sumame Forenames Last Test| Time of Test] Previous Test Date of Birth| Categorisation Position/Aank. 5]
b [BOOTH_MAX - Max 21/06/2012] 10:55:03] 28/07/1984|HSE: 1 4-no data -
BOOTH_RHS Black Rachel 21/06/2012] 10:32:51 O1/01/1975|HSE: 1 4-no data
BOOTH_PR Fiogoers Paul r 2|HSE: 1 4-no data - -
BOOTH_H Hery James | BB Import from CASS0 S5 s Frariee a0 o Qualty i
JHOO1 Henry James F3[HSE: 1 Quality Engineer [l
Lines of data in buffer—————————
Corfigure I Miew
Choose ‘Data Export’ from the Series 5 audiometer
Impart | Stare LCancel
K| d
Patierts: 5 | Resords: 5 [ Fiter: D | Sorted
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Return to the CA850 Series 5 and select the function key adjacent to ‘Data export’ (this is found within the
‘Test’ mode). This operation will save the current test record to the Audibase application. Return to the
Audibase screen and after a few seconds the ‘Lines of data in buffer’ text box on Audibase will show ‘1’. This
data can be viewed by clicking on the ‘View’ button if required.

To save the data to the database, click on the ‘Store’ button. The confirmation message ‘Are you sure?’ will
appear, followed by a message to report if the save was successful. For example, if the Patient Number, Test
Date and Test Time are the same as a record that already exists in the database, the import is considered a
duplicate and will be rejected.

A4.5 Disconnection and Reconnection of Audiometer

If the audiometer is disconnected from the PC it is possible that an alternative COM Number will be assigned
when it is subsequently reconnected. If this is the case the following warning will be displayed:

r ~
Warning CA850 connection lﬂhj

Unavailable comm port. Please select a different comm port from the connection
tab in the configuration window, and check cable is plugged in.

Q

Audibase5.5 will need to be configured with the correct COM Number to allow data transfer from the
audiometer to the PC, and the procedures outlined in Section A4.3 should be repeated to identify the correct
COM Number for use with Audibase5.5.

If Audibase is started without the audiometer connected, the warning message above may be displayed. Click
on OK to continue using Audibase, but remember that the audiometer will need connecting and/or configuring
before data transfer can be performed.

To suppress this message (for example if an alternative audiometer is to be used for an extended period) the
“COM -” port may be selected from the Configuration — Connection screen as shown below:

-
B) Configuration

Backup/Repair | Databaze Setup] Questionnaire | Test Analysis  Connection | Patient Options

For connection to CA850 Audibasze audiometers please uge this screen.

LCancel

[9CH |

Cag50 Part
& o5 o = Delay between exported records
54 05 1s
" 53

oy .

D-0116491-C (OMO016) — Audibase Operating Manual



Remember that the appropriate COM port will need to be selected before data transfer from the CA850/5 can
again be performed.

Note that when the configuration menu is accessed it must be exited using the ‘OK’ button (do not
close the box using cancel or the close button) or no changes will be made.
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APPENDIX 5: USING THE MODEL 116 AUDIOMETER

A5.1

Connection

If an audiometer other than the CA850/4 was used when the Audibase software was installed (see Section 3)
then the necessary device drivers for the Model 116 audiometer will have been installed at the same time as
the main Audibase program.

It is thus simply a matter of connecting the audiometer to the PC using the USB cable supplied. The audiometer
will automatically be recognised.

If a CA850/4 is the only audiometer that has been connected previously then it will be necessary to install
additional device drivers. This should be initiated automatically and the procedure described in OM032 the
Amplivox Operating Manual for USB Driver Installation should be followed. Refer to Appendix 1 for installation
troubleshooting.

A5.2

Transferring test results

Start Audibase and either enter the details of a new patient (see Section 7) or use the register screen
to select an existing patient
Ensure that valid audiometric data is available at the audiometer — these are the “retained thresholds”
described in the operating manual
When the correct data is available at the audiometer, select the Test dropdown menu and then Get
Test Data or clicﬁ< on the Get Test Results icon:

|

| |

The audiogram page will be displayed showing the previous test result for that patient (if any); data
from the audiometer will have been transferred to Audibase and is displayed

To accept and save the new data it must be saved by selecting the Edit dropdown menu and then
Save or clicking on the Save icon:

-

If the data is not to be saved select the Edit drop-down menu and then the Cancel Insert/Edit option
or use the Cancel Insert/Edit icon:

%

Eap > .
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APPENDIX 6: USING THE MODEL 170 AUDIOMETER

A6.1

Connection

If an audiometer other than the CA850/4 was used when the Audibase software was installed (see Section 3)
then the necessary device drivers for the Model 170 audiometer will have been installed at the same time as
the main Audibase program.

It is thus simply a matter of connecting the audiometer to the PC using the USB cable supplied. The audiometer
will automatically be recognised.

If a CA850/4 is the only audiometer that has been connected previously then it will be necessary to install
additional device drivers. This should be initiated automatically and the procedure described in OM032 the
Amplivox Operating Manual for USB Driver Installation should be followed. Refer to Appendix 1 for installation
troubleshooting.

A6.2

Transferring test results

Start Audibase and either enter the details of a new patient (see Section 7) or use the register screen
to select an existing patient
Ensure that valid audiometric data is available at the audiometer — these are the “retained thresholds”
described in the operating manual
Note that it is possible to transfer data stored in any of the audiometer's memory locations, but it is
first necessary to load the required data — refer to the Model 170 operating manual for details
When the correct data is available at the audiometer, select the Test dropdown menu and then Get
Test Data or click on the Get Test Results icon:

|

Ee—

The audiogram page will be displayed showing the previous test result for that patient (if any); data
from the audiometer will have been transferred to Audibase and is displayed

To accept and save the new data it must be saved by selecting the Edit dropdown menu and then
Save or clicking on the Save icon:

-

If the data is not to be saved select the Edit drop-down menu and then the Cancel Insert/Edit option
or use the Cancel Insert/Edit icon:

%
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APPENDIX 7: USING THE PC850 AUDIOMETER

A7.1 Introduction

The PC850 is intended for use with Audibase5.5 as an automatic audiometer that may be launched directly
from Audibase with results transferred back into Audibase at the completion of a test. To undertake this function
additional software is provided on the Audibase5.5/PC850 installation disc.

A7.2 Software Installation

Installation of the PC850 software will be carried out when the main Audibase software is installed, and should
be a transparent process.

A7.3 Setup of the PC850

Connect the PC850 using the USB cable — the audiometer will automatically be recognised. Refer to Appendix
1 for installation troubleshooting.

A7.4 Operational Checks of the PC850

Connect the headphones, patient response switch and 5V power supply to the PC850 audiometer, and ensure
the PC850 audiometer is connected to the PC via a USB cable. Switch on the PC850 audiometer.

Create a dummy patient record in Audibase (refer to Section 7.2 of this operating manual), to gain
familiarisation with the operation and controls of the PC850 audiometer.

Select the ‘Launch Test’ "() icon.

The PC850 software will now be launched:

[E) Aorivon PCa30 - Gatabase. -

Ele Tet View Options Peuse About

Dea & gofl ) *yo EW-A

N I I — I I —

250 s K "5 % * ® o w oL = 500 1% "% ES ;@ - " L

The option to confirm to commence a test will then be displayed:
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Audibase l J

Run Test?

Click on Yes to initiate a test using the last test settings. If you wish to make changes to test settings, select
=

No and change configuration settings and then initiate a test using the ‘Run Selected Test’ = _icon.

Once you have concluded your operational checks, close the PC850 window. If a full test was not completed
during your operational checks, select Yes to the confirmation message:

WARNING J

Test not complete
Exit anyway?

The Audibase Window will be displayed. If no thresholds were obtained, after a short time a message will be
displayed indicating that no results have been transferred:

Instrument Error

Mo results: (153)

Click on OK to any such message.

Select the Edit drop-down menu and use the Cancel Insert/Edit option or use the Cancel Insert/Edit toolbar
button.

When closing the PC850 software and returning to Audibase, remember to use the “Edit > Cancel Insert/Edit”
option or the Cancel Insert/Edit icon on the toolbar in Audibase to cancel the test operation.

To delete the dummy data refer to Section 7.6 of this operating manual.

Refer to the separate operating manual for the PC850 audiometer for further details about the operation of this
instrument.

A7.5 Transfer of Stored Data from the PC850

It is possible to retrieve data previously stored on the PC850 audiometer without launching a test. The
procedure is described below:

oy .
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Start Audibase and either enter the details of a new patient (see Section 7) or use the register screen to
select an existing patient

Ensure that valid audiometric data is available at the audiometer — these are the “retained thresholds”
described in the PC850 operating manual

Note that it is possible to transfer data stored in any of the audiometer's memory locations, but it is first
necessary to load the required data — refer to the PC850 operating manual for details

When the correct data is available at the audiometer, select the Test dropdown menu and then Get Test
Data or click on the Get Test Results icon:

| %
L-—._‘]

The audiogram page will be displayed showing the previous test result for that patient (if any); data from
the audiometer will have been transferred to Audibase and is displayed

To accept and save the new data it must be saved by selecting the Edit dropdown menu and then Save
or clicking on the Save icon:

=
If the data is not to be saved select the Edit drop-down menu and then the Cancel Insert/Edit option or use
the Cancel Insert/Edit icon:
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APPENDIX 8: USING THE OTOSURE AUDIOMETER

A8.1 Introduction

The Otosure is an automatic audiometer and is controlled by a computer using software for this purpose
(Audibaseb.5). From within Audibase5.5, the audiometer software (Otosure) may be launched directly with
results transferred back into Audibase at the completion of a test. The Otosure software is provided on the
Audibaseb5.5/0Otosure installation disc.

A8.2 Software Installation

Installation of the Otosure software will be carried out when the main Audibase software is installed, and should
be a transparent process.

A8.3 Setup of the Otosure

Connect the Otosure using the USB cable — the audiometer will automatically be recognised. Refer to Appendix
1 for installation troubleshooting.

A8.4 Operational Checks of the Otosure

Connect the headphones and patient response switch to the Otosure audiometer, and ensure the Otosure
audiometer is connected to the PC via a USB cable.

Create a dummy patient record in Audibase (refer to Section 7.2 of this operating manual), to gain
familiarisation with the operation and controls of the Otosure audiometer.

Select the ‘Launch Test’ E) icon.
The Otosure software will now be launched.

Close any dialogue boxes in the Otosure window and select the Manual Test option:

M)

Move the mouse pointer over the “Present” icon in the Otosure window and ensure a tone is heard from an
earphone. Use the arrow keys on the PC keyboard to change the level and frequency of the tone. Use the “L”
and “R” keys on the PC keyboard to switch between earphones.

Press the patient response switch and ensure that the “Response” icon in the Otosure window changes colour
to light green and returns to dark green when the switch is released.

The above will demonstrate the basic functionality of the audiometer.

When closing the Otosure window and returning to Audibase, remember to use the “Edit > Cancel Insert/Edit”
option or the Cancel Insert/Edit icon on the toolbar in Audibase to cancel the test operation.

To delete the dummy data refer to Section 7.6 of this operating manual.

Refer to the separate operating manual for the Otosure audiometer for further details about the operation of

this instrument.
| amplivox 2 .
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APPENDIX 9: IMPORTING AN AUDIBASE3 DATABASE

To import a database created with Audibase3 into Audibase5.5 it must first be exported using the Audibase3
application. This should be done prior to installing the new program files for Audibase5.5.

A9.1 Export Data from Audibase3

Open the original Audibase3 application

Sort tests by date order

Select the Export function either by clicking the Export icon or the Export command on the Exchange drop
down menu

With the Export dialogue box active, click the Configure function

With the Configuration dialogue box active, the following settings need to be made if using Audibase with
the default database file settings:

Conversion file: C:\Program files\Amplivox\Audibase3\Adb.3.cvt
Import/Export via: File
Export file C:\datal.csv

Select these settings by using the Browse function positioned to the right of the input field; the Export file
called datal.csv is a temporary data file

When the appropriate settings have been made, click OK

The Export dialogue box is now shown with the transfer buffer indicating the number of records to be
exported

Click Export followed by Yes in the Confirm dialogue box; all the selected records will now be copied to
the temporary file C:\datal.csv.

A9.2 Install Audibase5.5

See Section 3 for installing Audibase5.5. Once you have installed the program, import the records from
Audibase3 into Audibase5.5 following the routine outlined in the Section below.

A9.3 Import Records into Audibaseb.5

From the main menu select File — Import — Import Audibase3.1 and the following dialogue box is displayed:

r B
Create Baseline [_J

Create baseline audiogram from previous results contained in oldest record?

L

This provides the option to use the oldest record as baseline data for the patients. If this option is required click
on Yes.

Eap > .
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The following dialogue box is displayed:

8 x Y
Sort Import lﬁ

Make sure the import file is sorted in test date order.

Cancel I

This allows confirmation that the test records in the file to be imported have been sorted in date order. Click
on OK to confirm, and the following dialogue box is displayed:

B Import Audibase 3.1 Data -

Records Imported so far

Click on start and a window opens to allow selection of the Audibase3 export file C:\datal.csv created as
described above:

IEJ Open &J
(L) & » Computer » OSWin7(C) » v | %3 || Search 05 win 7(C 2|
Organize v Mew folder == « [l I@I
Bl Desktop i Name ° Date modified Type g
8 Downloads | eA0f469ceda3dT36973eT3e748 24/01/201210:48  File folder
' Dropb P
- Cropnex 4. Intel 23/01/201216:02  File folder
AlRecen Bl 2 MSsOCache 24/01/201209:16  File folder
) J Moah_Systern_4.3.0_1936 04/10/201213:35 File folder
= Libraries e -
j = . Moah_System_4.3_1934_pre 27/08/2012 14:55 File folder
2 E:“_'me"ts | Perflogs 14/07/200904:20  File folder |
' P_”“ | Program Files 17/05/201210:16  File folder 3
a1
) Pictures | Program Files (x86) 12/08/201302:08  File folder
B Videos ProgramData 26/10/201108:54  File folder
= C 0 J Users 06/07/2011 12:07 File folder
k- it
—= Snp | Windows 07/08/20131319  File folder
& OSWin7(C) L] datal.csv 15/08/201314:43  Microsoft Excel C ~
= Windows 8 (E) SlaT o - 5
File name: datal.csv [ Audibase31 csv file -

I [ open o] [ cance | I

Select this file, click on Open and the database will begin to load. If a record is found that has no date of birth
associated with it (used by Audibase5.5 for categorisation) there will be the option to enter this data. At the
end of the download the database will be ready for use.

In general it is recommended that the Filter function is used, see Section 7.8, to identify all patients with no
date of birth and that this data is entered if available.
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